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Warranty Statement 

There are no warranties, express or implied, with respect to the contents of this document, and all information 
provided herein is provided “as is.” Osteoid reserves the right to periodically change the information that is contained 
in this document; however, Osteoid makes no commitment to provide any such changes in a timely manner or at all. 

Limitation of Liability 

In no event shall Osteoid or its affiliates be liable to any party for any direct, indirect, special, or consequential 
damages in connection with your use of this document, including, without limitation, loss of business revenue or 
earnings, lost data, damages caused by delays, lost profits, or a failure to realize expected savings, even if Osteoid 
was expressly advised of the possibility of such damages. 

End of Life Statement 

TxSTUDIO software is dependent on its hardware requirements. The life-cycle is limited only by the availability of 
the required hardware. 

Trademarks 

Osteoid and related marks, images, and symbols are the exclusive properties of, and trademarks of, Osteoid Inc. All 
other brands and marks are the properties of their respective owners. 

Copyright 

Documentation for TxSTUDIO and the operating software are copyrighted with all rights reserved. Under the 
copyright laws, this documentation may not be reproduced, transmitted, transcribed, or translated into any human or 
computer language in whole or part without the prior written permission of the copyright holder. 

About Osteoid and TxSTUDIO Software 

This version of TxSTUDIO was released as an update to the original TxSTUDIO software from Osteoid, Inc. In this 
document, TxSTUDIO refers to the latest version of the Osteoid TxSTUDIO. To learn more about Osteoid, access 
the Osteoid website (www.osteoidinc.com). 

Intended User 
 

TxSTUDIO is designed to be used by medical and dental professionals who have been appropriately trained to 
use 3D CT imaging devices and read the image data generated by the devices. 

Language 

The original language of this manual is English.  

Caution: Federal law restricts this device to sale by or on the order of medical and dental clinicians. 
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Indications for Use 

TxStudio is a software application used for the display and 3D visualization of medical image files from 
scanning devices, such as CT, MRI, or 3D Ultrasound. It is intended for use by radiologists, clinicians, referring 
physicians, and other qualified individuals to retrieve, process, render, review, store, print, assist in diagnosis 
and distribute images, utilizing standard PC hardware. Additionally, TxStudio is a preoperative software 
application used for the simulation and evaluation of dental implants, orthodontic planning, and surgical 
treatments. 
 
This device is not indicated for mammography use. 
 
General Precautions 

  

  

 

Warning: The software provides tools for dental prosthetics creation and design but is dependent on the user to determine 
and use the appropriate parameters. Incorrect parameters may affect the quality of  the final milled products or otherwise 
to surgical delays or complications. 

  

 

Warning: Please ensure all hardware devices with the software are password-protected from unauthorized use and all patient 
information is secure. 
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Introduction 
TxSTUDIO Imaging Software 

natomage, Inc. is a medical imaging company 
composed of  a cross-functional team consisting of  the most 
elite researchers, mathematicians, engineers, software 

developers, business analysts, industry leaders, academic faculty, and 
dental specialists. We believe that TxSTUDIO software will enable 
the profession to initiate a revolution of  unimaginable scope and 
magnitude. Ultimately, our mission is dedicated to developing simple 
and refined software specially designed for dentists to utilize the most 
advanced cutting edge software and technology to better serve their 
patients. With TxSTUDIO software, doctors can create 3D 
volume renderings on their own computers, get cross sections, trace 
nerves, place implants, print images, save images, and many more functions. The software is designed to reconstruct 
these 3D volume renderings from DICOM files generated by CBCT, Medical CT, and MRI radiography machines. 
TxSTUDIO is intended for use as a planning and simulation software in the placement of  dental implants, 
orthodontics, and surgical treatment. 

his manual is intended to provide supplementary information to your direct training with a support 
representative. For correct and safe use, it is highly recommended that prospective users seek TxSTUDIO 
training from their support representative. In this document, TxSTUDIO refers to the latest version of  the 

Osteoid TxSTUDIO software. For more information about the TxSTUDIO Reference Manual, please contact the 
Osteoid customer support team at support@Osteoid.com. 

A 

T 
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System Requirements 
Below are the minimal and recommended system configurations. 

aving an adequate computer system is essential to using TxSTUDIO efficiently and generating the highest 
quality images possible for enhanced analysis and presentation for your patients and colleagues. The most 
important element is the video card (3D graphics chip or GPU). If  your system does not have an 

appropriate video card, you can purchase and install video cards for desktop computers. 

TxSTUDIO has minimal system requirements; however, Osteoid recommends the following configurations to fully 
utilize all the features within the TxSTUDIO Software. The following recommendations have been updated in 
January 2016: 

Summary 
 

Minimum Recommended 

CPU Pentium 3 Intel Core i7 4000 series or comparable multi-
core processor 

RAM 3GB 4GB 

GPU / Graphics Card ATI Radeon HD 4650 or Nvidia GeForce 
9800 GT ATI Radeon HD 6800 or comparable 

Hard Disk 100 GB 500 GB 

OS Windows 7 32-bit 
Windows 7 64-bit, Windows 8* 64-bit, 
or Windows 10* 64-bit  

*For versions 5.1 and up 
 
Mac Users 

 OS Hardware 

Not Compatible Apple OS, Parallels MacBook Air, Mac Mini 

Fully Compatible 
Apple Bootcamp (requires a full license of  
Windows) 

iMac, MacBook Pro (15in), Mac Pro 
Note: Please check if a dedicated graphics card 
(Nvidia/Radeon) is included. 

 
Graphics Cards / GPU 

Brand Model Series Low-End Options Recommendation High-End Options 

ATI Radeon HD 4600 – 
R9 290X Radeon HD 6450 Radeon HD 6800  

series 
Radeon HD 7970 
Radeon R9 290X 

Nvidia GeForce GT 430 –  
GeForce GTX Titan 

GeForce GT 635 
GeForce GTX 645 GeForce GTX 650 GeForce GTX 760 

GeForce GTX 660 Ti 
 
  

H 
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Laptop Recommendations 

IMPORTANT: Ensure the laptop has a dedicated video card. Integrated graphics cards alone, such as Intel HD 
Graphics, are insufficient for 3D rendering. 

Note: Graphics processor options may vary. Please check with the laptop manufacturer for details on graphics processor options. 
  
Dell 

Sizes Model Series Graphics Processor Options Weight 

11'', 14'', 
17'', 18'' 

Alienware M 
Nvidia GeForce 765M 
Note: Known issue with new GT 700M series drivers; will only 
work with “Nvidia driver 311.48.1.3.24.2” as of 1/29/2014 

4.4 – 11.7 lbs 

15'', 17'' Inspiron R ATI Radeon HD 8850M or Nvidia GeForce GT 750M 6.1 - 7.3 lbs 

15'', 17'' Studio XPS Nvidia GeForce GT 730M or GT 740M or better 5.8 - 7.4 lbs 

 
HP (Warning: HP brand laptops have a known issue with switchable graphics. A BIOS update from the HP website may be necessary to run 
TxSTUDIO with the intended graphics hardware.) 

Sizes Model Series Graphics Processor Options Weight 

15'', 17'' Envy ATI Radeon HD 8750M or Nvidia GeForce GT 750M 5.6 – 7.5 lbs 

15'', 17'' Pavilion ATI Radeon HD 8670M 5.5 - 6.6 lbs 

 
For additional information, recommendations or assistance, please contact the Osteoid Tech Support 
Department at (408) 333-3484 or email support@osteoidinc.com 
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Installing TxSTUDIO 
About the License Type 
The authorization code provided for activation should be one of  the two license types below. If  the license type is 
not known, please contact the distributor of  the license, which can be either Osteoid or a CBCT manufacturer that 
bundles TxSTUDIO/Invivo5 licenses. 

Perpetual Licenses 
 This is a single-use license for one computer. Internet connection will be 

required for the initial installation but not during subsequent use of  the 
software. If  Internet access is not available, the license can be manually activated 
by the distributor’s tech support. 

 
Network Licenses 
 This license can install up to four computers that are on the same Internet 

network as at least one perpetual-licensed computer. Hence, a network license 
can only be used after a perpetual computer is installed. Internet connection will 
be necessary to launch the software.  
 

Note: Please ensure each code is entered on the desired computer. Once a code has been activated, you 
must contact the distributor of  the license to transfer the license. 
 
Internet Requirement 
While perpetual computers only need Internet connection during the initial installation, network computers will 
require Internet to access the software. If  the Internet connection becomes unavailable, the network computers will 
fall onto a grace period of  eight hours. After the grace period ends, the license will be inactive until Internet 
connection linked to a perpetual computer is reestablished. 

 
Website Installation Instructions 
1. Go to http://www.osteoidinc.com 

2. Select “Dr. Login.”  

3. Enter username and password. 

o (Username and password can be obtained by calling ISI technical support at 1-800-205-3570.) 

4. Click on the TxSTUDIO Installer. 

5. Click “Save File.” 

6. Run File. 
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TxSTUDIO Setup Wizard 

Before proceeding, please ensure the computer is connected to the Internet. TxSTUDIO Setup will check for 
certain components that are important to the performance of  the software. A result of  “Pass” or “Fail” will be 
provided as the components for that computer are compared to a list of  the most compatible components. A 
Fail result will not prevent the installation from completing and is only intended as a warning of  the possibility of  
suboptimal software performance as a result. 

 

OpenGL Vendor: Associated with the 
manufacturer of  the graphics processor 

OpenGL Version: Associated with the 
driver version of  the graphics hardware 
component 

Memory: The quantity of  RAM installed 
on the motherboard 

 

Click Next to continue. 

 

 

Enter the numerical authorization code. If  
you have an alphanumeric license key, click 
Advance and put in the key in the blank 
provided. 

Click Next to continue. 
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Installation Preferences: The user can specify the folder for software installation as well as the level of  
functionality with which the software initially opens. A PACS-compatible user interface can also be installed 
instead of  the typical File Manager. 
 
Full Functionality Mode: Selecting this 
option will have all view tabs enabled after 
the installation is complete.  

Unchecking this function will install the 
software with only Section, ArchSection, 
Volume Render, Implant, Gallery, and 
Model Tabs visible. The missing tabs can 
be enabled in the Preferences dialog of  the 
File menu. 

PACS Options: Files can be opened from 
or saved onto PACS through the PACS user 
interface. Selecting “Full PACS” will disable 
opening or saving files locally. Selecting 
“Export PACS Only” options will disable 
saving files locally. 
 
Only select these options if  you have a PACS in place.  

  

Review the End-User License Agreement 
and accept the terms if  desired to proceed 
with the installation. 

 

 
Click Next to continue. The program will proceed with installation until completed. Clicking Finish will close the 
wizard. 
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Validating the Installer File 
 
1. Right-click the Installer file and select “Properties” to open the Properties window. 

2. Open the “Digital Signatures” Tab. 

3. Select “Anatomage, Inc.” and press Details. 

4. Verify that the Digital Signature Information is “OK.” 

 

The following pictures are for example purposes only. The name of  the installer and Digital Signature Information is dependent on the 
release version and may change accordingly.  
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Feature List 
An overview of  the various features provided by TxSTUDIO. 

 

 Directly Opens DICOM Data from Any CT Machine 
 

 Invivo File Compression 
 

 Section and Multislice View Operations 
 

 Volume Rendering of Scan Data 
 

 Linear, Angular, Circumferential, Area, and Volumetric Measurements*  

 
 Image Capture and Export 

 
 AVI (Movie) Capture and Export 

 
 Implant, Abutment, and Restoration Treatment Planning 

 
 Bone Density Evaluation 

 
 Quick Airway Volume Measurement and Evaluation 

 
 Automatic Superimposition and Mirroring 

 
 Platform for the AnatoModel service 

 
 Report Generation 

 
 

 
 
 
  *All measurements are performed with the metric system. 
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Software Layout 
The following is a description of  how TxSTUDIO is organized by Menu Bar, Tool Bar, View Tabs, View Control Panel, and 
Rendering Window. 

 

 

 

 

 

  

 

  
View Control Panel 

The View Control Panel is the 
region where patient images can 
be manipulated and controlled.  

The View Control Panel is 
associated with a specific View 

Tab. 

Rendering Window 
Rendering Window is the region 

where patient images are 
displayed.  This window can be 
customized within many of  the 

View Tabs by using the Toolbar. 

View Tabs 
The View Tabs allow 

you to perform specific 
tasks or look at specific 
subjects of  interest by 
adjusting the Toolbar 
and View Controls. 

Menu Bar 
The Menu Bar 
allows you to 

perform application 
operations such as 
open, save, close, 
print, capture, etc. 

 

Toolbar 
Tools can be accessed to 

perform certain functions on 
patient images.  Sets of  tools are 
associated with a specific View 

Tab. 
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TxSTUDIO Preferences 
This section will explain the different options within the Preference window of  TxSTUDIO. The TxSTUDIO Preferences includes 
options for Display settings, Volume Rendering settings, as well as File Manager settings. 

Accessing the TxSTUDIO Preferences: 
 In the Menu bar of  the TxSTUDIO, select “File.” 
 Select “Preference…” from the “File” drop-down. 

 
Display Preferences 

 

GUI Settings 
 Background: Sets the background color for the 

rendering window. 
 Measurement Font Size: Sets the measurement 

font size to a size preset: small, medium, or 
large. 

 Measurement Text Color: Sets the text color for 
measurement notations. 

 Tag Text: Provides an additional label to the 
right hand corner of  the rendering window. 

 Date Format: Current date format for case 
information display. 

 Continuous View:  
o Checked – Switching between view presets 

for volume renderings will show 
intermediate volume positions. 

o Unchecked – Switching between view 
presets will not show intermediate 
positions; the volume will “jump” to the 
final position. 

 Make Text Annotations Global: when checked, 
previously placed or new text annotations 
added to any 2D slice view except group slices 
(TMJ, ArchSection) will be visible when 
scrolling past the slice the measurement was 
placed on. 

 Cycle 2D Distance Measurement Color: 
Measurement colors will cycle with every 
measurement that is added. 

 Enable Multiple Distance Measurement Mode: Distance Measurement will become a toggle on/off  
button for measurement mode. Toggling “on” this mode will continue to pick beginning and end points 
for linear measurements with each click after the first measurement has been created. 

 Tru-Pan On By Default: This setting determines if  a scan will initially have Tru-Pan enabled in specific 
tabs. 

 Tabs: This section determines which View tabs are seen by the user when the program is running. 
Checked boxes will be available while unchecked boxes will hide those tabs. Changes are made after 
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restarting the program. 
 Auto save 2D view setting on application exit: This setting will determine if  2D view settings made in each 

of  the applicable tabs will be saved automatically upon program closure and be reloaded with the next 
opened case. If  left unselected, the user will have to manually save the configuration by clicking Save View 
Settings in the working tab. The specific 2D view settings that will be saved in each tab are given in the 
table below: 

 
ArchSection Slice Interval, Cross Section 

Width/Interval/Thickness, Auto R-L, Pano Image 
Type, Pano Ruler Enabled, Brightness/Contrast 
mode, Layout (including Axial vs. Cross Series and 
Print Layout), Sharpen Filter, Color Preset, Nerve 
Diameter, and Nerve Visibility 
 

Section Rendering presets, custom Brightness/Contrast (if  
the Dental preset is chosen), Sharpen Filter, 
Volume Clipping, Slice Thickness 
 

Implant Layout, Restoration Lock, View Preset, 
Brightness/Contrast, Sharpen Filter, Volume 
Clipping, and Remove Crown 

  
TMJ Lateral Width/Interval/Thickness, Pano Ruler, 

Brightness/Contrast mode and settings, Layout 
(including sequence type and Print Layout), 
Sharpen Filter, Color Preset, Focal Trough 
Thickness and Symmetry, Pano Render Mode 
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Volume Rendering Preferences 

 

Volume Rendering View Settings 
 Quality Resolution: Sets the limit for the resolution of  the 

image. This can be set to either a user-defined number or 
set to Unlimited. 

 Init (Initial) Rendering: Sets the rendering quality upon 
opening TxSTUDIO. 

 Shaded Slice Sampling Rate: Accepts a numerical value 
that sets the sampling rate to improve image quality at the 
cost of  performance. 

 Use lower resolution while moving volume: Positional 
changes of  the volume will be rendered at a low quality 
resolution while maintaining the quality resolution setting 
in the final position. 

 
Volume Rendering Range 
 The user can define the range of  Hounsfield Units that 

will be rendered. This cannot be set when “Use 
Automatic H.U. Range” is checked.  

 Checking “Non-CT Modality Use Scalar for Min-Max” 
will allow the user to define the Min and Max Scalar units 
that will be rendered. 

 
Material 
 Various properties can be adjusted to change the appearance of  a volume rendering. Ambient, 

Diffuse, and Specular effects can be rendered in different colors.  
 The degree of  Emission and Diffuse can be adjusted with the respective sliders. 
 Shininess is set to a number – higher numbers denote less shininess. 
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File Manager Settings 

 

Dicom/Invivo File Path Settings 
Folder paths can be set for each of  the Invivo and DICOM file 
type options. When one mode is selected, the program will use 
the file paths associated with that file type mode, but the user 
may still save or open either file type at any time. 
 
File Path Preferences for Different Users 
In the situation that there are multiple users on a single computer 
with TxSTUDIO installed across multiple user accounts, the file 
paths for all new accounts will initially take on the preferences 
defined by the user administrator account. Non-admin accounts 
may redefine their file path settings, but they will be overwritten 
the next time the settings are changed on a user administrator 
account. 

 

File Paths 
 Anatomage Case Path: The Anatomage Case path serves as a backup case folder. Backups are made 

when cases are opened from locations set in the “Copy Files to Anatomage Case Folder Before Open”. 
In DICOM File Manager mode, the Anatomage Case path will also serve as a DICOM directory for the 
File Manager window. 

 Default Open Path: This is the starting location for attempting to open a case through File → Open in 
the Menu bar. 

 Default Save Path: This is the starting location for saving a case file in TxSTUDIO.  
 
Copy Files to Anatomage Case Folder Before Open 

This section allows the user to save a copy of  a case that is to be opened in the Anatomage Case Folder 
if  it is in any location besides this folder, such as on a different location on a network, on a CD-ROM, 
or in a different folder on the local hard drive. 
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PACS Settings 

 

Import Configuration 
 Configure: Click to edit the server and client 

information from which cases will be imported. 
Export Configuration 
 Configure: Click to edit the server and client 

information to which cases will be exported. 
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Basic Features 
The following is a detailed explanation of  the various features provided by TxSTUDIO. 

DICOM & Invivo File Loading with the File Manager 
  

To open a DICOM data set, first launch the TxSTUDIO software. The File Manager will appear upon startup 
allowing you to open the data. If  you installed TxSTUDIO with PACS mode please refer to page 27. 

 

 
 

Click the Browse File button to search manually for 
the data you would like to open. If  you are opening 
DICOM data, as shown to the right, simply highlight 
one of  the .dcm files and click Open. It does not 
matter which DICOM file you choose, just click 
one and the software will open all the files within the 
data set present in that folder. If  you are opening an 
Invivo file just click it and press Open. Invivo files 
can also be compressed and opened. 
 

 
 
The File Manager allows you to automatically store and reopen recently viewed cases. This allows for quicker 
access to cases. By default, files will be saved in the “Anatomage Cases” folder, located in “My Documents.” 
This location can be changed in the Menu Bar → File → Preferences → File Manager. 
 

0 
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Invivo/DICOM Options: This filters the 
displayed cases by file type. 

 

Scan searches the default open file path 
chosen for the file type selected and 
displays the respective cases. 

 

TxSTUDIO allows you to quickly search 
through your DICOM file directory by 
typing in the Patient Name or Scan Date in 
the search fields (shown right).  

 
 
If  you close a case and want to reopen another one, click on “File” → “Open” and the File Manager will 
appear again. 
 
Selecting Options… will display additional options to delete the recent case history or to delect select cases 
from the list. This will only modify the cases that are displayed on the File Manager and does not delete the 
actual files from where they are saved.  
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Invivo/DICOM File Saving 
Invivo provides four options for saving and each type 
differs in the size of  the saved file and its compatibility with 
other software. Choosing “File” → “Save As...” for any file 
will present the dialog on the right. Choosing “File” → 
“Save” when a DCM file is open will save an INV in the 
specified location or simply overwrite the same file if  it is 
of  the INV file type. 

 

Invivo 
The following work can be saved as an Invivo file 
(.inv).  

 Case Information & Patient 
Orientation 

 Traced Nerves 
 Implants & Implant Measurements 
 Volume Measurements, Landmarks and 

Annotations 
 Images captured within the Gallery 
 Sculpting Operations 
 †Models imported from MDStudio 
 †Tracings performed in 3DAnalysis 

†
These functions require the installation and activation of  additional 

software modules 
 

 

Click “File” → “Save As...”, browse to the area 
you would like to save, name the file (default is 
the patient’s name) then click “Save.” The user 
may also specify the file type of  the file they 
would like to save. 
 
The following save dialog box will show up. 
Select the default “Full” option for saving 
everything without losing any information. 
  

DICOM 
When the DICOM file type is chosen, the output 
files are either a single lossless DICOM or a multi-
file DICOM (with DICOMDIR) accompanied with 
an Invivo workup file containing workup data and a 
folder of  exported Gallery images in DCM format.  
 
For single-file DICOMs (Figure 1), the save dialog 
will ask for a location to save the files. For multi-file 
DICOMs (Figure 2), you will have to create or 
choose a folder to save the slices and DICOMDIR 
file. The DICOMDIR file presents the directory of   

Figure 1: Single-file DICOM Save Dialog 
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slices to Invivo to accelerate the loading speed. 
The DICOM File Save Option dialog (Figure 3) will present numerous options for saving the file. 
Compression will reduce the size of  the file (at the cost of  increased saving and loading speed), 
“Lossless” or “Lossy” determines the quality (amount of  data) of  the file that is saved, and resampling 
will change the resolution by the selected factor in each orthogonal plane. The workup file description 
will be used to differentiate between workup files on PACS. 
 

 
Figure 2: Multi-file DICOM Save Dialog 

 
Figure 3: DICOM File Save Options 

 
Custom Saving Dialog 

Available for Invivo file saving: By selecting the “Customize” 
option, the custom saving dialog shows up. In the dialog box, one 
can compress the data. For the main volumetric image, you can 
select to save it as “LossLess” or “Lossy” compression. With 
LossLess compression, the volume is compressed to about 1/3rd 
– 1/4th of  the original size. With the Lossy compression option, 
the file size can be dramatically reduced, but the image is altered. 
Resampling the data will reduce its size very dramatically by 
combining voxels to reduce the overall voxel count. Rescaling the 
image will reduce the number of  shades of  gray in the image. You 
can also choose to selectively compress images in the gallery, the 
clinical content (such as implants and nerve tracings), and the 
models. 

 

 
Warning: Saving files in lossy format degrades image quality. 

Saving As an Invivo Project File 
Click “File” → “Save As Project...” to save the case as an APJ, Invivo Project file. This file will save only changes 
made to the original scan data. It requires a reference data (.dcm scan data or .inv file) when opening. If  TxSTUDIO 
cannot locate the reference data, it will ask you to locate the data again. Because it is saving only the changes to the 
original, APJ files save much faster than full INV files. 
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DICOM File Loading with PACS 
If  you chose to install the PACS mode of  TxSTUDIO, upon launch, the PACS File Import window will open 
instead of  the File Manager. At initial launch, the settings will need to be configured to connect with the database, 
but this information will be retained subsequently. 

 

Without installing under PACS mode, this interface can still be accessed by choosing “File” → “Import PACS.” 

PACS Configuration 

 
Click Configure to set up the connection to PACS. 
Input the appropriate server data and test the 
connection to verify the information.  

Scans from PACS will be stored locally in the Local 
Storage Directory folder while they are open. The 
option to delete the files locally after opening them 
is available. 

Transport Layer Security (TLS) setup can also be 
configured. 

Once the information is complete, click OK. This 
data will be saved until manually reconfigured.  

PACS File Loading 
 

Click Query to load the cases stored on PACS. Filter cases using the patient information fields. Select a case from 
the Case List and click OK. TxSTUDIO will search for any workup files associated with the patient. Select an 
existing workup file and click Open or click Cancel to open the raw patient scan. 
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PACS File Saving 
 

Click on File → “Export PACS” to save the file onto PACS.  

 Configure: Opens the PACS Configuration dialog. 
 For descriptions of  the different DICOM types, refer to page 25. 
 Without installing under PACS mode, this interface can still be accessed by 

choosing “File” → “Import PACS.” 
  

Export DICOM & Viewer to CD… 
This function will create an executable file containing the 3D volume data from the scan that is currently open as 
well as a 2D TxSTUDIO viewer program. This function is designed to allow the sharing of  scan data from a 
TxSTUDIO user to a non-TxSTUDIO user on shareable media such as a CD, DVD, or flash drive. Note that some 
antivirus programs may detect the file as a virus due to its executable format. 

TxSTUDIO Viewer: Running this 
file will initialize the viewer program 
and then load the embedded scan data. 
The TxSTUDIO Viewer contains 
Section, ArchSection, and Gallery 
functionality  

                
Export DCM Only to CD… 
This function will export the currently opened scan as a compressed or uncompressed DICOM or a full, 
compressed, or customized setting Invivo file. The exported image file will be placed in the temporary burn location 
in the computer.  
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Case Information Display 
To display or hide the Case Information for a specific patient, go to the “File” → “Case Info.” Click Anonymize 
then click OK to save the changes. 

 

 

Image Capture to File 
To capture an image to file of  the active display click “View” → “Capture to File.” Browse to the location where 
you want to save the image, type the name of  the file, choose the file type on the “Save as type” drop-down, and 
click Save. The file can be saved as bmp, jpg, or png format. Jpg is the most popular file format for images but there 
is a small amount of  color degradation. Bmp preserves the 
image, but the file size is big. The .png is an effective lossless 
format that does not degrade the color. 
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Image Capture to Gallery 
Selecting “Capture To Gallery” will capture an image of  the Rendering Window and save it to the Image List (see 
Gallery Tab features for additional information). 

 

 

Image Capture to an Email 
Selecting “Capture To Email” will capture an image of  the rendering window and attach it to an email ready to send. 
This will require e-mail client setup before use (ex: Microsoft Outlook, Mozilla Thunderbird). 
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Image Navigation 
Below is an explanation showing how to manipulate images in the rendering window with the keyboard and mouse. 

Slider Scroll  
 

 
 

 Click the mouse cursor over any slider (e.g. axial slice, brightness, etc.) and move it to adjust the image. 
 Click the slider and keep the mouse cursor in the Control Panel before scrolling the mouse wheel forward 

or backward to achieve the image adjustment you like. 
 
 
Zoom In/Out 

 Place the mouse cursor in the center of  the image you want to zoom. 
 Hold down the “Control” key + left-button on the mouse. 
 While holding down the buttons indicated above, move the mouse up 

and down on the screen. 
 This shrinks/enlarges the image: Down vertically zooms out. Up 

vertically zooms in. 
 

 
 
 
Pan (Shift) 

 Place the mouse cursor in the center of  the image you want to shift. 
 Hold down the “Shift” key + left-button on the mouse. 
 While holding down the buttons indicated above, move the mouse any 

direction to achieve the desired image displacement. 
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Free Rotate  
Applicable only for 3D images.    

 
 Place the mouse cursor in the center of  the image you want to shift. 

Hold down the left-button on the mouse. 
 While holding down the left-button, move the mouse in any 

direction to achieve the desired rotational position. 
 

 

 

Free Rolling  
Applicable only for 3D images.     
 
 Hold down the “Space” key + left-button on the mouse. 
 While holding down the buttons indicated above, move the mouse 

up and down to rotate the image about a central axis. 
 
 
 

 

Increment Rotate 
Applicable only for 3D images.     
 
 Use the keyboard arrows     to rotate the 3D Model 1 degree up, down, right, or left, 

perpendicular to the computer screen. 
 
 
 
 
Increment Roll 
Applicable only for 3D images.     
 
 Hold down “Control” and use the keyboard arrows   to rotate the 3D Model 1 degree rolling left or right 

about a central axis. Pressing   without the Control key pressed will roll the image left or right. Use  to 
roll the image up or down.  
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Anatomical Plane Clipping  
Applicable only for 3D images.     
 
 Place the mouse cursor over the center of  the image, then scroll 

the mouse wheel forward or backward to clip the anatomic plane 
as you like (after enabling clipping in the Control Panel). 

 
 
 
 
 
Scroll Slice 
Use when you would like to move through the series of  sections when in 
either the Section, ArchSection, or Pano views.   
 Place the mouse cursor in the center of  the image then scroll the mouse 

wheel forward or backward to move one section at a time as you 
advance through the data slices. 

 
Note: In the ArchSection Tab, you must first create an arch spline to activate this feature.   
 
 
Move/Rotation Widget 

 Superimposition View: Click on either the ring or the arrows circling the patient and 
move it in the direction you want the patient to be oriented.  

 Model View: Use to move a model through a portion of  the volume for simulation 
creation. Click on either the ring or the arrows circling the model and move/rotate it 
in the direction you want it to move. 

3D Restoration Widget
The 3D Restoration widget is designed to maximize visibility in the 
renderer and provide a high level of  versatility in crown positioning 
and sizing. The resizing handles only appear when the camera 
perspective is within a range of  angles that is relatively orthogonal 
to it. 

 The rotation circle appears on the same plane as the two 
resizing tools that are close to orthogonal to each other and 
the camera perspective and feature eight arrows for 
rotation. 

 The red resizing handle can be selected and dragged 
toward/away from the crown to reduce/expand the 
mesiodistal size of  the crown. 

 The green resizing handle can be selected and dragged  
 

toward/away from the crown to reduce/expand the height of  the crown. 
 The blue resizing handle (not shown) can be selected and dragged toward/away from the crown to 

reduce/expand the buccolingual size of  the crown. 
 The crown can be clicked and dragged freely along a plane orthogonal to the camera angle. 

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Full Screen Mode and Keyboard Shortcuts 
Below is an explanation pertaining to running the software in full screen mode without toolbars and controls. 

Switching to Full Screen Mode 
From the software menu, select “View” → “Full Screen.” “Full screen stereo” is only applicable for the stereo 
display system. To return back to the normal screen mode, press “Esc” key on the keyboard. Full screen is not 
applicable to the ArchSection Tab and Implant Tab. 

Keyboard Shortcuts at Volume Rendering View 
The following keyboard shortcuts are available in Volume Render view: 

Category Keyboard Shortcut Description 

View Preset 

1 Inverse Volume Rendering 

2 Soft-Tissue 1 

3 Soft-Tissue 2 

4 Soft-Tissue + Bone 1 

5 Soft-Tissue + Bone 2 

6 Teeth 

7 Bone 

8 (unassigned) 

9 (unassigned) 

0 Gray Scale 

Clipping Control 

P Toggles clipping plane on/off 

A Axial clipping set 

S Sagittal clipping set 

C Coronal clipping set 

F Flip the clipping direction 

Page Up / Page Down Move the clipping plane 

Q Open Free-Sculpt Tool 

W Open Point-to-Point Sculpt Tool 

Copy/Paste Ctrl+C/Ctrl+V 
Text/Circle/Arrow notations can be 
copied and pasted  

Delete Del 
Pressing this key will delete the selected 
measurement, comment marker, notation, 
airway volume, or nerve 

 



 

ANA003 Rev G.  17 June 2022                                         Page 35 of 160                                                                       UM-TXS-ENG-54G 

Keyboard Shortcuts for Report Design 

Category Keyboard Shortcut Description 

Report View 

t Add Text Control 

i Add Image Control 

s Add Slice Control 

n Next Page 

p Previous Page 

r Insert Page 

d Remove Page 

g Toggle Printing of  Page 

Ctrl + s Save Template 

Ctrl + o Load Template 

Ctrl + n New Template 

Delete Delete Currently Selected control 

Esc Cancel Control Creation 

f Move Control to Foreground 

b Move Control to Background 

Slice Capturing in 
ArchSection and 
TMJ Views 

Hold s + Left Mouse Click Select Single Slice 

Hold a + Left Mouse Click Select Group of  Slices 
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The View Tabs: 

ArchSection View Features 
ArchSection View Tab is a sectional image exploration view. Instead of  conventional X-Y-Z sections, this view allows to the user to 
review the image in dentally meaningful perspectives using multiple cross sections, traversing the lengths of  the dental arches. 
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ArchSection: Toolbar 
Shown below is the Toolbar and tools that are loaded with the ArchSection Tab: 

 

 
Reset View: Resets the window to the original view. 

 
Create Arch Spline (Focal Trough): After selecting this tool, you can create a new arch spline or edit 

an existing arch spline. First, left-click on the point you would like to start and continue adding points 
by left-clicking. After you have marked your final point, right-click or double-click to finalize the arch 
spline. When modifying an existing arch spline, drag the control points to the desired positions. 

 
Arch Spline (Focal Trough) Ruler: Places ruler along the arch spline for easy reference. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 

number in millimeters will automatically display. 

 
Angle Measurement: Select this option and mark three points on the volume and the angle between 

them will appear. Clicking on their control points and moving the cursor can modify measurements. 
Click on the measurement and press the “delete” key to delete it. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of  the desired 
area. Double-click or right-click to end the measurement. A number in millimeters square will be 
automatically display. Click on the measurement and press the “delete” key to delete it. 

 
Polygonal Measurement: When selected, you may mark an unlimited number of  points on the 

volume and the total between the first point and the last point will appear. Right-click your mouse to 
indicate that you have marked your last point. Clicking on the point and moving the cursor can 
modify points. Click on the measurement and press the “delete” key to delete it. 

 
Layout: Creates a different layout to your preference. After clicking on the layout icon, a list of  various 

layout options will appear. Click on the layout of  your preference to apply it. These options allow for 
different case workup images. 

 
Toggle Cursor Visibility: Conceals or displays cursors. 

 
Information Display: Displays or hides case information embedded in the data. 

 

Arrow Notation: Allows an arrow to be drawn on the image. 

 

Circle Notation: Allows a circle to be drawn on the image. 

 

Text Notation: Allows text to be written and edited on the image. 

 
View Sequence: Allows for the creation of  custom camera sequences and AVI file movie 

capturing. Refer to the Volume Render View Sequence (p. 59) section for additional 
information and description. 

 
Slice Capture Mode: Opens the Slice Capture Manager to enable the capture of  slices or groups 

of  slices from a series of  cross sections. Requires the creation of  a slice group in the Report 
Tan (see Report: Features and Report: Group Management Creation for details) and an 
activated Report module. 
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HU Measurement: Allows for a calculation of  the HU value of  an area within a bounding box. 

The user can create multiple HU measurements on a single image. Measurement information is 
displayed next to the defined measurement area that the user creates, and the text can be 
repositioned by clicking and dragging the text box with the left-mouse button. The font color 
and size of  the measurement text can be changed using the preference settings from the File 
menu. The HU measurement will also display the calculated area and standard deviation for the 
region chosen. 

 

  

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off  of  the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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ArchSection: Control Panel 

 

Layout: 
 “Screen” layout is optimized for viewing the image on 

the computer screen. “Print Out” layout is optimized 
for printing the image on paper. With Print Out layout, 
what you see on screen will be what you get on the 
paper in life size. First capture to Gallery, then print 
from Gallery to ensure the image is life size. 

 Change Layout allows you to adjust the layout with 
different amounts of  slices and orientations. 

Axial Section: 
 Interval: Distance between the subsequent axial 

sections. 
 “Adjust Range and Orientation” will switch to the view 

that you can change the upper and lower limit of  pano 
and cross sections. You can also reorient the image in 
this view. 

Cross Section: 
 Width: Cross-section width 
 Interval: Distance between the subsequent cross 

sections. 
 Thickness: Allows for the cumulative thickness of  the 

slices to be viewed in the cross sections. 
 Auto R-L: This will allow the cross section to be 

oriented to a consistent R-L orientation on screen. If  
turned off, the cross-section orientation will be 
consistent to the arch spline. 

Panoramic Image: 
 Slice mode will show you a single cross section along 

the panoramic curve (yellow). This mode is used for 
tracing the nerve. 

 X-ray will show you the ray sum (reconstructed x-ray) 
in the focal trough.  

 Tru-Pan™: This option enables the one-click 
volumetric pano that can be created from scans taken 
by a i-CAT© Cone Beam 3D system. See more 
information in the Tru-Pan™ section of  the manual. 

View Control: 
 Brightness and Contrast allow you to adjust the image. 
 The All drop-down allows you to adjust 

brightness/contrast in different areas independently. 
 Different Color Presets can be used to view the images 

in color. 

 Image Sharpening: Filter applies the selected sharpening filter from the dropdown menu to the 2D 
slice renderers. 
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Nerve Pathway: 
 New Nerve: Starts a new nerve tracing. 
 Modify: Allows editing of  the selected nerve tracing. 
 Visibility: Controls the visibility of  the nerve in the section and X-ray renderers. 
 Nerve Node: Select a specific node for modification. 
 Diameter: Selects the diameter of  the nerve that has been traced or a specifically selected node. 
 Delete: Deletes the last placed node during the tracing or the entire nerve if  Modify is active. 

HU Shape: 
 The shape of  the HU measurements can set to Rectangle, Circle, or Ellipse. Each shape is defined 

by two left- clicks and allows adjustments to the size to be made by first left-clicking to select the 
image and then left-clicking and dragging the red dots to adjust the size or the yellow perimeter to 
adjust the position. 

Save View Settings 
Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 
section in Preferences (pg. 18) for more information on which settings are saved for this specific tab.  

  

 

 
  

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of the nerve can lead to surgical 
complications if  diagnosis, treatment plans and/or actual treatment is based off  of  the incorrect tracing. It is critical for the end 
user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software problem with nerve 
tracing or have further questions or concerns about nerve tracing, please contact Osteoid support at (408) 333-3484 or email us 
at info@osteoidinc.com 
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ArchSection: Creating A Nerve Pathway 
Creating a Nerve Pathway (e.g. Inferior Alveolar by following the mandibular canal to its exit). 
 Click New Nerve. 
 Left-click the mouse where you want the nerve to start. 
 Move the mouse to the next point along the nerve path and left-click again. 
 Click Delete to remove the last-placed node if  it is mispositioned. 
 Repeat this procedure for the entire length of  the nerve. 
 2.0mm is the default diameter of  the nerve pathway, but you may adjust it for your preference. 
 Press Done to finish. 

 
Editing a Nerve Pathway 
 Click on a nerve tracing to select it. This highlights it in a brighter red color. 
 Set the Nerve Node drop-down menu to “All” or a specific node.  
 If  “All” is selected, the entire nerve tracing’s diameter can be adjusted. 
 If  a single node is selected, it will be highlighted in the scan, and its diameter and position may be adjusted 

independently. The nerve node diameter is adjusted in the Diameter drop-down menu. The highlighted node 
can be moved by clicking and dragging it across the scan. 

 
Deleting a Nerve Pathway 
 The Delete button can be used if  a point was plotted in the wrong spot; it will delete the last point added. 
 Once a nerve has been completed and Done has been clicked, the nerve can be deleted by clicking on it and 

pressing the “delete” key on the keyboard or the Delete button. 
 Visibility will turn the nerve on or off  from view. 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of  the nerve can lead to surgical 
complications if  diagnosis, treatment plans and/or actual treatment is based off  of  the incorrect tracing. It is critical for the end 
user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software problems with nerve 
tracing or have further questions or concerns about nerve tracing, please contact Osteoid support at (408) 333-3484 or email us at 
info@osteoidinc.com 
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ArchSection: Rendering Window 

 
 
Arch Cursor: Notice the green, orange, and brown coordinate indicators. These ArchSection coordinate 
indicators show where you are spatially located within the ArchSection modeling window. 
 Cross Section Indicator: The green lines give the location of  the cross sections along the arch spline.  
 Axial Slice Indicator: The orange line shows the axial coordinate position within the section.  
 Arch Spline: The brown spline in the center of  the arch spline represents the current position where the arch 

section has moved. 
 Cross Section: Mouse scrolling within any one of  the three sagittal frames advances the slices to the patient’s 

right or left and causes the green coordinate indicator to move anteriorly or posteriorly in the axial and pano 
sections simultaneously. 

 Axial Section: Mouse scrolling within the axial section advances the sections superiorly or inferiorly and causes 
the red coordinate indicator to move superiorly or inferiorly in the cross or pano sections simultaneously. 

Pano Section: Mouse scrolling within the coronal frame advances the slices buccally or lingually and causes 
the brown coordinate indicator to move buccally or lingually in the axial and cross sections simultaneously.                         
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Section View Features 
The Section View Tab gives the ability to view the X, Y, and Z sections (axial, coronal, sagittal) and user-created, custom sections 
simultaneously for 2D visualization, measurements, and the utilization of  several image enhancement features. TxSTUDIO also integrates 
3D functions in the Section View Tab. 
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Section: Toolbar 
Shown below is the Toolbar and tools that are loaded with the Section View Tab: 

 

 
Reset View: Resets the rendering window to the original view size. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 

number in millimeters will automatically display. Click on the measurement and press the “delete” key 
to delete it. 

 
Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click the 

last point to create an angle. A number in degrees will automatically display. Click on the measurement 
and press the “delete” key to delete it. 

 
Area Measurement: After selecting this tool, click multiple points along the boundary of  the desired 

area. Double-click or right-click to end the measurement. A number in millimeters squared will be 
automatically display. Click on the measurement and press the “delete” key to delete it. 

 
Reorientation: Click this button to re-orient the image. A circle will show up in each section. Grab the 

arrow widgets and rotate the image to the desired orientation. 

 
Layout: Creates a different layout to your preference. After clicking on the layout icon, a list of  various 

layout options will appear. Click on the layout of  your preference to apply it. 

 
Toggle Cursor Visibility: Turns cursor on and off. 

 
Information Display: Displays or hides case information embedded in the data. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 
HU Measurement: Allows for a calculation of  the HU value of  an area within a bounding box. The 

user can create multiple HU measurements on a single image. Measurement information is displayed 
next to the defined measurement area that the user creates, and the text can be repositioned by clicking 
and dragging the text box with the left-mouse button. The font color and size of  the measurement 
text can be changed using the preference settings from the File menu. The HU measurement will also 
display the calculated area and standard deviation for the region chosen. 

 
View Sequence: Allows for the creation of  custom camera sequences and AVI file movie capturing. 

Refer to the Volume Render View Sequence (p. 59) section for additional information and 
description. 

 
Airway Measurement: This button will open the airway volumetric measurement interface. More 

details can be found in the Airway Measurement section (pg. 49). 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
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resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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Section: Control Panel 

 

Layout: 
 Default: Reset to the original layout. 
 Change Layout: Click to choose custom layout. 

View Control: 
 Brightness & Contrast: Can be adjusted for each of  the 

presets to enhance your image. 
 Rendering Preset (drop-down list): Color presets that 

allow for better visualization of  certain anatomic 
structures, soft tissue profiles, airway, etc. The color 
rendering is only for visualization. The colors are based 
on densities but DO NOT represent the density value of  
the bone. 

 Sharpening Filter: Applies the selected sharpening filter 
from the drop-down menu to the 2D slice renderers. 

 Slice Thickness: Uses ray sum when reconstructing the 3D 
image along each orthogonal plane. 

Additional View: 
 3D Volume: This option allows 3D volume rendering in 

the fourth corner of  the window. 
 Custom Section: This option allows for the creation of  a 

custom section. 

Custom Section:  
 Click Create to start a custom section. By clicking two 

points, a customized section can be created on any cross 
section to better visualize anatomy along that axis. The 
custom section can be navigated by clicking and dragging 
the arrows to rotate, the endpoints to lengthen, or the 
center point to drag the entire section freely. 

 Delete: Removes the custom cross section made in the 
rendering window. 

Style: 
 Explorer: Allows the user to freehand rotate and move the 

custom section. The custom section can be navigated by 
clicking and dragging the arrows to rotate, the endpoints to 
lengthen, or the center point to freely drag the entire section. 
The Explore button automatically rotates the custom section 
about its center at the designated RPM. 

 Line: Allows the custom section to be dragged along the 
2D section renderer back and forth in only a direction 
perpendicular to the custom section.  

Slice Thickness: Adjusts the slice thickness of  the custom section. Slice thickness can also be adjusted using the 
circular handles flanking the center of  the section. 
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3D Volume Clipping: 
 When 3D volume is enabled, this option allows you to clip the volume to see the internal anatomy. The 

clipping plane will be synchronized with section cursors. 

Image Info: 
 Dimension, resolution, and field of  view size are summarized. 

Pointer Coordinates: 
 IJK or XYZ: coordinates give the user the ability to examine the coordinate of  the cursor upon the 

absolute coordinate system. 
 Scalar Value is the gray scale value of  the voxel pointed by the cursor pointer. H.U. or Hounsfield 

unit, is an approximate value of  the voxel calculated by “Rescale Slope” and “Rescale Intercept” in 
DICOM information. H.U. value approximations may not be as accurate if  your CT hardware calibration is off. 
Contact your hardware manufacturer for more information about H.U. accuracy. 

HU Shape: 
 The shape of  the HU measurements can set to Rectangle, Circle, or Ellipse. Each shape is defined 

by two left- clicks and allows adjustments to the size to be made by first left-clicking to select the 
image and then left-clicking and dragging the red dots to adjust the size or the yellow perimeter to 
adjust the position. 

Save View Settings 
 Saves the current 2D View settings to be reloaded upon opening any case. See the Display 

Preferences section in Preferences (pg. 18) for more information on which settings are saved for 
this specific tab.  
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Section: Rendering Window 
This window allows viewing of  the X, Y, and Z sections (axial, coronal, sagittal) and custom sections or a 3D view 
simultaneously. This allows the clinician to have very accurate 2D visualization and 2D measurements. 

 

 
 
Scroll wheel: Move mouse pointer to the desired cross section. Use the scroll wheel to move the slice up 
and down. 
 
Cursor: Grab one of  the cursors (axial, sagittal or coronal). Move the cursor in the desired direction. The 
corresponding image will be updated. 
 
Center Circle: Pick a point inside the center circle. Move the circle in the desired direction. The other two 
images will be updated. 
 
Zoom: Click and hold the left-click mouse button on the image and the “Ctrl” key on the keyboard. Drag the 
mouse cursor up and down to zoom in and out. 
 
Pan: Click and hold the left-click mouse button on the image and the “Shift” key on the keyboard. Drag the 
mouse cursor to move the image. 
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Section: Airway Measurement 

 Airway Measurement: Selecting the icon will prompt the dialog box below. Click OK to continue. 

 

 

 
Tracing the Profile: 

 Use the scroll-wheel to locate the mid-sagittal plane. 
 Pick points along the airway in the sagittal section 

to define your measurement path with the left-click 
button. 

 Right-click when finished. 

Viewing the Volume Measurement: 
 Invivo will convert your profile tracing into a 

volume rendering and superimpose it onto the scan 
data. An isolated airway can be examined in the 
variable window. 

 The minimum cross-sectional area and total volume 
are displayed next to the airway measurement. 

 Graphs of  the RL and AP distance as well as the 
cross-section area are displayed. Individual values 
can be obtained by clicking on the graphs. 

 The airway volume and measurement values can be 
deleted by left-clicking once on the airway, then 
pressing “delete” on the keyboard.  

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the 
imaging, there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The 
software measurement tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the measurement 
value depends on threshold values; thus, user must set proper thresholds to get the best estimate of  the desired structure. 
The measurements must not be used as the sole metric for any treatment. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or actual 
treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements 
correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the image data and the 
hardware scanner that generated the image data. The measurement cannot be more precise than the resolution of  the 
image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, the boundary is not 
always well defined. The apparent boundary depends on the current brightness and contrast setting. The boundary may 
shift as the user makes adjustments to brightness and contrast. The user must understand the limitation of  the 
measurement value before applying to the patient. If  you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at (408) 
333-3484 or email us at info@osteoidinc.com 
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Section: Light Box 

 

Change Layout has the option to change 
the Section view format to a “Light Box” 
style.  

 The Light Box is composed of  4-
32 sections of  either axial, sagittal, 
or coronal views.  

 The user may also define the Slice 
Interval by selecting a drop-down 
option between 0.1-20.0mm or by 
manually entering a number within 
that interval on the keyboard. 
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Volume Render View Features 
The Volume Render Tab shows the patient in three-dimensionally reconstructed views and allows you to explore the internal structures 
and never-before-seen anatomy of  the patient. 
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Volume Render: Toolbar 
Shown below is the Toolbar and tools that are loaded with the Volume Render View Tab: 

 
 

 
Reset View: Resets the rendering window to the original view size. 

 
Left View: Automatically orients the volume so the patient is facing left sagittal. 

 
Left ¾ View: Automatically orients the volume so the patient is facing 45° left sagittal. 

 
Front View: Automatically orients the volume so the patient is facing the front. 

 
Right ¾ View: Automatically orients the volume so the patient is facing 45° right sagittal. 

 
Right View: Automatically orients the volume so the patient is facing right sagittal. 

 
Top View: Automatically orients the volume so you are oriented above the patient. 

 
Bottom View: Automatically orients the volume so you are oriented below the patient. 

 
Back View: Automatically orients the volume to the posterior view. 

 

Quick Zoom: Click the zoom icon, then the point on the volume to zoom in. Use Reset View icon to 
go back to normal size. 

 

Quick Slice: Once activated, clicking on a point on the volume will open a 2D zoom window in that 
location. The zoom window can be scrolled through using the mouse wheel and also shows the profile 
of  any implants on that slice. 

 

Freehand Sculpture: Freely outline an area and remove the volume perpendicular to the plane of  the 
screen. The volume inside or outside the selection can be chosen by clicking in the respective areas. 

 

Polygon Sculpture: Outline an area by placing a series of  points and right-clicking. The volume 
perpendicular to the plane of  the screen will be removed. The volume inside or outside the selection 
can be chosen by clicking in the respective areas. 

 

Marker: When selected you may mark a point on the volume and X,Y,Z coordinates (axial, sagittal, 
vertical) will appear. Clicking on the point and moving the cursor can modify points. Click on the point 
and press the “delete” key to delete it. Control Panel features allow the values to be hidden or exported 
to a report. 

 

Distance Measurement: Select this option and mark two points on the volume and distance will appear. 
Clicking on the point and moving the cursor can modify points. Click on the measurement and press 
the “delete” key to delete it. Control Panel features allow the values to be projected to 2D, hidden, or 
exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle between 
them will appear. Clicking on their control points and moving the cursor can modify measurements. 
Click on the measurement and press the “delete” key to delete it. Control Panel features allow the 
values to be projected to 2D, hidden, or exported to a report. 
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Polygonal Measurement: When selected, you may mark an unlimited number of  points on the volume 
and the total between the first point and the last point will appear. Right-click your mouse to indicate 
that you have marked your last point. Clicking on the point and moving the cursor can modify points. 
Click on the measurement and press the “delete” key to delete it. Control Panel features allow the 
values to be projected to 2D, hidden, or exported to a report. 

 
Volume Measurement: This button will open the volumetric measurement window. 

 

Airway Measurement: This button will open the airway volumetric measurement interface. More details 
can be found in the Airway Measurement section (pg. 58). 

 

Comment Marker: You can enter a point in the volume and enter comments. Enter the text you would 
like to appear in the Insert Comment window and press OK. 

 
Quick Measurement: Click to activate a ruler at the tip of  the cursor. Click again to turn off. 

 

Grid: Toggles between four different grid layouts for simple assessment of  size, measurement, and spatial 
location. 

 
Patient Orientation: Click to change patient orientation. 

 

Information Display: Displays or hides case information embedded in the data. 

 

Setup View: Allows option to view either parallel or perspective views in 3D. For Airway Measurement, 
you can set the threshold and displayed color range. 

 

View Sequence: Allows for the creation of  custom camera sequences and AVI file movie capturing. 
Refer to the View Sequence description in the Volume Render View section (p. 59) 

 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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Volume Render: Control Panel 

 

Rendering: 
 You can select different methods of  rendering to suit your 

needs. 
 Method: “Performance” is fast but there are some 

rendering artifacts. “Quality” gives the highest level of  
detail, but response is slower. “Default” is in between the 
other two options. 

 Reconstruction: There are three possible reconstruction 
methods: Volume Rendering, Maximum Intensity 
Projection, and X-ray. 

View Control: 
 Color Presets: Gray Scale, Inverse, Soft Tissue 1, etc. allow 

better visualizations of  certain anatomic structures, soft 
tissue profiles, airway, etc. This is achieved by displaying 
specific densities with specific colors.  

 Opacity: Allows for the translucency/opacity to be 
adjusted. 

 Brightness & Contrast: Can be adjusted for each of  the 
presets to enhance your image.  

Clipping: 
 Click the “Enable Clipping” box to slice the image along 

the predefined anatomical planes (sagittal, axial, coronal, 
and arch). 

 Scrolling the mouse wheel or slider will move the clipping 
plane. 

 To switch a view to the opposite side, click “Flip.” 

Measurement: 
 Once landmarks or measurements are defined, the text 

can be edited in the edit box. 
 Measurements can be projected as 2D values or hidden by 

clicking the appropriate box. 
 Delete All will delete all measurements within the 

rendering window. 
 Report exports the values and annotations to a .CSV file 

for viewing and/or computations in Excel or similar 
programs. 

Annotation: 
 Edits selected comment/annotation in the text field. 
 You can toggle added comments on/off  by selecting “Visible.” 
 Layout: Sorts all added comments in the Rendering Window based on selected setting 

(Horizontal, Stick to Point, User Dragged, Vertical, Vertical Even Distributed, Vertical Round 
Distributed). 
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Volume Render: Patient Orientation 
The reorientation tool provides the user a way to orient the volume 
through each orthogonal view (sagittal, coronal, axial) using references 
lines as well as to reset the image to the default coordinate system. 

 After selecting the reorientation icon in the toolbar, left-click and 
drag each reference line to the approximate proper location on 
the volume (ex. Frankfort Horizontal in sagittal view).  

 Left-click and drag the rotation handles to rotate the volume to 
match the reference line. Continue through each view until the 
desired orientation is achieved.  
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Volume Render: Rendering Window 
One of  the most powerful features of  TxSTUDIO is the remarkable rendering quality and speed at which the 
software works. The simplicity of  this window is that it only displays the volume, patient information (if  desired), 
and the opacity, brightness and contrast values. 

 

 

Please refer to Image Navigation (p. 31) for information about controlling and 
adjusting these images. 

 
 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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Volume Render: Volume Measurements 

 

The Volume Measurement interface allows you to estimate displaced volume (cc or cubic millimeters) of  a 
specific anatomical structure. You must first perform sculpting operations to isolate the desired anatomical 
structure.  

Then, press the Volume Measurement  button. The new window will open and the volumetric 
measurement value will be displayed. Finally, you can adjust the threshold values to obtain desired 
measurements. The volume measurement function is linked to rendering; the Inverse rendering preset can be 
used to take volumetric measurements of  air. 
 
 
 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the 
imaging, there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The 
software measurement tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the 
measurement values depend on threshold values; thus, user must set proper thresholds to get the best estimate of  the 
desired structure. The measurements must not be used as the sole metric for any treatment. 

 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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Volume Render: Airway Measurement 

 Airway Measurement: Selecting the icon will prompt the dialog box below. Select OK to continue. 

 

 

Tracing the Profile: 
 Use the scroll-wheel to locate the mid-sagittal plane 
 Pick points along the airway to define your 

measurement path with the left-click button 
 Right-click when finished. 

 

Viewing the Volume Measurement: 
 TxSTUDIO will convert your profile tracing into a 

volume rendering and superimpose it onto the scan 
data. 

 The minimum cross-sectional area and total volume are 
displayed next to the airway measurement. 

 The color range and threshold can be adjusted by 
selecting the Setup View icon in the Toolbar:  

 The measurement data can be hidden by checking the 
box for “Hide All Values” in the Control Panel. 

 The airway volume and measurement values can be 
deleted by left-clicking once on the volume, then pressing 
“delete” on the keyboard. 

 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the imaging, 
there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The software 
measurement tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the measurement value 
depends on threshold values; thus, user must set proper thresholds to get the best estimate of  the desired structure. The 
measurements must not be used as the sole metric for any treatment. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or actual 
treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements 
correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the image data and the 
hardware scanner that generated the image data. The measurement cannot be more precise than the resolution of  the 
image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, the boundary is not 
always well defined. The apparent boundary depends on the current brightness and contrast setting. The boundary may 
shift as the user makes adjustments to brightness and contrast. The user must understand the limitation of  the 
measurement value before applying to the patient. If  you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at (408) 
333-3484 or email us at info@osteoidinc.com 
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Volume Render: Movie Capturing and Customized View Sequences 

 

 

 

  View Sequence: 
 Allows you to create your own sequences by clicking on Insert 

button for each step you want the volume to move in your 
sequence. 

 If  you want a movie that spins left to right, and then turns up for 
a submental view, you would add a new frame for each step, and 
the video capture of  it will connect the positions in a seamless 
movie. 

 You can integrate multiple, different rendering presets so that it 
switches not only in sequence, but also in colorizations. 

 Video sequences can be saved for future use and then loaded 
using the Load and Save buttons under Sequence File. 

 Click on VIDEO Capture to open a dialog to customize and save 
the movie file. 

 

Movie Capture: 
The VIDEO Capture button allows you to customize, capture, and export an AVI 
(movie) file of  the volume rendering sequence. 
 

 Select Change to determine the AVI file name and save location. 
 Various codecs that are on your computer can be used to capture 

the movie at different qualities. If  you experience any trouble with 
the video quality, a different codec may be better. 

 Set your frames/view and frames/sec to desired values. 
 More frames/view will make the video smoother. 
 More frames/sec will make the video run faster. 
 Add an ending logo by selecting Browse and choosing an image 

file to display at the end of  your video. 
 Select “Add Logo” to add the ending image. 
 Set your duration and background color. 
 Click Capture once everything is set up to automatically export 

the video to the specified location with the specified name. 
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Implant View Features 
The Implant View Tab allows you to access the full-featured implant planning module. 
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Implant: Toolbar 
Shown below is the Toolbar and tools that are loaded with the Implant View Tab: 

 

 
Reset Views: Resets the rendering window to the original view. 

 
Left View: Automatically orients the volume so the patient is facing left sagittal. 

 
Left ¾ View: Automatically orients the volume so the patient is facing 45° left sagittal. 

 
Front View: Automatically orients the volume so the patient is facing the front. 

 
Right ¾ View: Automatically orients the volume so the patient is facing 45° right sagittal. 

 
Right View: Automatically orients the volume so the patient is facing right sagittal. 

 
Top View: Automatically orients the volume so you are oriented above the patient. 

 
Bottom View: Automatically orients the volume so you are oriented below the patient. 

 
Back View: Automatically orients the volume to the posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume and distance will 
appear. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. Control Panel features in Volume Render Tab allow the values 
to be projected to 2D, hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle between 
them will appear. Clicking on their control points and moving the cursor can modify measurements. 
Click on the measurement and press the “delete” key to delete it. Control Panel features in Volume 
Render Tab allow the values to be projected to 2D, hidden, or exported to a report. 

 

Insert Implant: To place an implant, first click the Add Implant icon, select the Tooth ID for the 
implant, then left-click the mouse on the spot that you want the implant to be placed. Note: specific 
manufacturers measure the implant from different points, so a measurement in the software might 
not be the same as the actual measurement of  the specific implant design. 

 
Show Implant Angle Dialog: Opens a window displaying all the angles between placed implants. 

 

Change Layout: Toggles the rendering window layout. 

 

Create Summary: Creates an Implant summary of  images that is added to the Gallery. Images contain 
ID (FDI), implant product, diameter, and length information in the lower right hand corner of  the 
screenshot. The user will also be given an option to print a reference chart which lists the implants 
placed (including implant site, manufacturer, product name, diameter and radius) for each arch. 

 

Toggle Grid: Toggles between two different grid layouts for use in the upper two section frames 
allowing quick assessment of  measurements and spatial location. 

 

Toggle Move Widget: Toggles the implant orientation widget on and off. 
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Information Display: Displays or hides case information embedded in the data. 

 

Change Model Visibility: Allows various models to be turned on or off  from view. 

 

Treatment Lock: Locks the implants in place so that they are not accidentally moved when viewing 
the 3D images. 

 

Preferences: Allows you to adjust the different rendering, color and visibility preferences. 

 

Density Profile Control: Adjust the settings for the displayed density profile around planned implants. 

 

Check Sleeves: The program will search for collisions between the sleeves, instruments, and stone 
models. 

 

Generate View Sequence: Opens a dialog that provides view sequence presets to create a video. 

 

Visualize Bone Graft Volume: Simulates a bone graft near the apex of  an implant and displays its 
volume. 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 

 

Warning: Any implants and restorations that are incorrectly visualized in Restoration Design Studio may lead to surgical 
complications or treatment delays. If  you notice any inconsistencies or software problems with implant or restoration planning 
or have further questions or concerns, please contact Osteoid support at (408) 333-3484 or email us at info@osteoidinc.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off  of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problems with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Osteoid support at (408) 333-3484 or 
email us at info@osteoidinc.com 

 

 



 

ANA003 Rev G.  17 June 2022                                         Page 63 of 160                                                                       UM-TXS-ENG-54G 

Implant: Control Panel 

 

Add Single Implant: 
 Click to add single implant to the 3D volume. 
 Adjust the implant orientation and placement using the 

move widget that appears on the selected implant. 

Planning Layout: 
 3D Implant: Place and adjust individual implants on 3D 

volume. 
 Pano Implant: Add multiple implants using the Pano view; 

select “3D Implant” to exit Pano view and re-adjust 
individual implants. 

Restoration: 
 Add All: Adds default restorations to all the implants. 
 Remove All: Removes all restorations. 
 Edit: Transfers the current progress to the Restoration Tab 

for advanced crown placement and design. See the 
Implant: Advanced Restoration Design section (pg. 71) 
for more information. 

 Lock to Implant: When selected, the implant and 
restoration will move as a single unit. 

View Presets: 
 Setup: Opens a dialog where the view presets can be 

configured. 
 Presets: Preset toggles that display the selected features as 

configured in the Setup. 
 Upper/Lower: Toggles the visibility of  the stone models if  

present. 

Volume Rendering: 
 Rendering Types: Different settings allow for better 

visualization of  certain anatomic structures, soft tissue 
profiles, hard tissue, etc. This is achieved by displaying 
specific densities with specific colors. 

 Brightness & Contrast: Can be adjusted for each of  the 
presets to enhance your image.  

 Visible: allows the 3D Volume Rendering to be turned on or off  from view. 
 Remove Crown: Only applicable with surgical guide-related modeling service options. 
 Tru-Pan™: This option enables the one-click volumetric pan that can be created from scans taken 

by a i-CAT© Cone Beam 3D system. (This setting is only displayed in the Control Panel when a 
Tru-Pan™ case is currently loaded.) 

 Sharpening Filter: Applies the selected sharpening filter from the dropdown menu to the 2D slice 
renderers. 
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Clipping: 
Click the “Enable Clipping” box to slice the image along the predefined anatomical planes (sagittal, axial, coronal, 
and arch). Scrolling the mouse wheel or moving the slider will move the clipping plane. To switch a view to the 
opposite side, click “Flip.” 
 
Implant: 
The implant section can be configured to only show specific implants as defined by the user. For more 
information, look at the Preferred Implant settings further in this section. 

 ID: Use the drop-down menu to select an implant to manipulate. The active implant will appear 
lighter in color than the others. 

 Manufacturer, Product Name, Diameter, and Length: The default is generic, but you may select a 
specific implant manufacturer, diameter, and length. 

Save View Settings 
Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 
section in Preferences (pg. 18) for more information on which settings are saved for this specific tab.  
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Implant: Rendering Window 

 
 

Used for more precise control and final detailed touches to implant treatment planning. Using the navigation 
discussed below, you can visualize all aspects of  the implant in the 3D volume. For further information on implant 
position and sizing using the implant widgets, please refer to the next section of  the manual. Once an implant is 
added, it will also appear in the Volume Render View. 

Axial Section: Top left window. This section is the view from the top of  the implant. The yellow line passing 
through the axis creates the view seen in the sagittal view. Scrolling the mouse wheel after clicking inside the axial 
window, or clicking and dragging the line will change the cross section seen in the sagittal view as the line rotates 
about the axis of  the implant. Asymmetrical (STL) implants can be rotated about the long axis in this view (see 
the next section). 

Sagittal Section: Middle left window. This section is the view from the side of  the implant. The A-B line passing 
through the implant creates the cross-section view that appears in the axial view and is set by default to be 
positioned at the level of  the implant emergence point. Scrolling the mouse wheel after clicking inside the sagittal 
window, or clicking and dragging the line will change the cross section seen in the axial view. The implant widget 
in this view allows for quick resizing of  implant length and diameter (see the next section). 

Density Profile: Lower left window. Displays a real-time visualization of  the volume density immediately 
surrounding the implant 

Volume Rendering: Right window. This frame allows user to change the implant position and orientation with 
the orientation widget within the 3D volume rendering. 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problem with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Osteoid support at (408) 333-3484 or 
email us at info@osteoidinc.com 
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Implant: View Preset Setup 
Visibility presets allow for easy switching between set views during implant planning. To configure these settings, 
click on Setup. These presets may also be modified in the Restoration Tab. 

 

 Edit Name: Click on any preset to select it. Type the 
new name into the field. 

 Visibility checkboxes hide or show features in the 
rendering window. 

 Implant Profile: Controls the visibility of  the solid 
implant cross section in the 2D renderers. When 
activated, the currently selected implant will have a red 
profile and the unselected implants will have blue 
profiles. When not activated, the selected implant will 
show an opaque cross section of  the implant and the 
unselected implants will show as blue profiles. 

 Abutment: Controls the visibility of  the abutment 3D model in the volume renderer or the colored profile 
in the 2D slice renderers. 

 Waxup: Controls the visibility of  the profiles in the 2D renderers and 3D models on the volume. Option 
is only available after they have been added by an Osteoid technician as part of  a surgical guide case workup.  

 Long Axis: Displays a colored rod running through the long axis of  the implant in the volume render. 
 Surrounding: Displays the surrounding volume around an implant. The collision zone is determined by 

the allowance defined in the preferences. 
 Trajectory: Displays the simulated trajectory of  the implant during surgical placement. 
 Sleeve: Controls the visibility of  the profiles in the 2D renderers and 3D models on the volume. Option 

is only available if  the mandibular and maxillary models are available as well as after the Check Sleeve 
action has been performed.  

 Nerve: Displays a 3D nerve in the volume render or a cross section of  the nerve in the 2D section 
renderers. 

 Angle: Controls the visibility of  the angle between the long axes of  adjacent implants as well as the angles 
of  the abutment for each implant. 

 Model: Controls the visibility of  the stone models. Varying degrees of  transparency can be obtained with 
the Opacity slider. 

 Restoration: Controls the visibility of  the 3D waxup models in the volume renderer and the colored 
profile in the 2D section renderer. The colored profile of  the selected restoration or restoration associated 
with the selected implant will be red while the unselected restorations will be pink. Varying degrees of  
transparency can be obtained with the Opacity slider. 

 Volume: Controls the visibility of  the volume render as well as the rendering type. 
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Implant: Model Visibility 

The  Change Model Visibility function will open the 
Model Object Settings dialog.  

 The “Mandible” and “Maxilla” checkboxes control 
all of  the model visibility options (except Profile 
Only and Density) and allow the user to turn off  the 
set of  models for each jaw independently. Note: The 
visibility checkboxes in Model Object Settings will not always 
match the checked/unchecked status of  the visibility 
checkboxes in the Control Panel. 

 The Stone Model and Waxups Opacity can be 
adjusted for both jaws. 

 

Implant: 3D Implant Widget

The  3D implant widget is designed to optimize visibility in the 
renderer and provide a high level of  versatility in implant positioning. 
The linear, colored arrows can be dragged to reposition the implant 
transversely. These arrows only appear when the camera perspective is 
close to orthogonal. The implant may also be moved along these 
directions using the keyboard arrow keys. 

 The yellow arrow (not shown) is parallel to the A-B line. 
 The blue arrow is orthogonal to the green and yellow arrows. 
 The green arrow runs through the long axis of  the implant. 
 The rotation circle appears on the same plane as the two arrows that 

are close to orthogonal to each other and to the camera perspective 
and feature eight handles for rotation. 

 

Implant: 2D Implant Widget
The 2D implant widget is designed to optimize visibility in the slice 
renderer and provide a high level of  versatility in implant positioning and 
sizing. The implant may also be moved along its long axis or orthogonally 
with the keyboard arrow keys. 

 The rotation circle has eight handles for implant rotation along the 
same plane as the currently displayed slice. 

 The two red handles can be selected and dragged toward/away from 
the implant to reduce/expand the diameter of  the implant 
sequentially through any available options for that implant model. 

 The two blue handles can be selected and dragged toward/away from 
the implant to reduce/expand the length of  the implant sequentially 
through any available options for that implant model. 

 The implant model itself  can be selected and dragged in any direction 
along the same plane as the currently displayed slice. 

 A rotation circle appears when the product cross section is selected 
that allows for implant rotation about the long axis of  asymmetrical 
implants (STL) in the top left section renderer. Please contact 
Osteoid for an updated list of  asymmetrical implants (STL). 
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Implant: 3D Implant Planning 

 In the Control Panel, click the Add Single Implant button.  
 The implant ID dialog will show up (image below). 
 Select the implant ID to be inserted. Press OK, and a new implant will appear on the mouse pointer. 
 Drag and drop the implant in 3D view onto the surgical site. (It helps to have the volume rotated so 

that the surgical site is centered.) 
 In axial view, align the yellow line such that the lower cross-section view becomes the view along 

mesiodistal direction. 
 In cross-section view, re-orient and position the implant so that its angle is as desired. 
 In axial view, align the yellow line such that the cross-section view becomes the view along 

buccolingual direction. 
 In cross-section view, re-orient and position the implant so that its angle is as desired. 
 Review the final implant position in 3D view. 

o To delete an implant, select the desired implant in the 3D view and press the “delete” key on 
the keyboard. The implant should be removed. 

 
A similar procedure can be done to add anchor pins to your 3D volume. Select which anchor pin you would like 
to add and follow similar steps for adjusting its position. 
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Implant: Pano Implant Planning 

 

 Select Planning Layout: Pano Implant 
under the Control Panel in the Implant Tab.

 Rendering window updates to pano view 
(left). 

 Adjust the ArchSection focal trough such 
that the middle profile passes through the 
dentition.  

 Drag implants to their desired locations and 
adjust their angles. 

 Click to select implants and manipulate 
them in the cross sections. 

 Click the nodes above the implant identification numbers and connect them with other implants to 
create parallel implant groups. Remove the implants from these groups by clicking on the nodes again. 

 Repeat for all desired implants. 
 Select Implant Planning: 3D to exit Pano-Mode and adjust individual implants. 
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Implant: Bone Graft Simulation 

 Select the implant that requires a bone graft and click the Visualize bone graft volume tool . 
 The graft simulation tool will appear as an arc that moves along the central axis of  the implant in the cross 

section. 
 Click to place the graft in the desired position. 
 The resulting graft will appear in the 2D sections in blue and in the volume rendering in off-white. 
 The volume of  the graft will be displayed in the volume rendering. 
 The graft can be deleted by clicking on it to select it and pressing the “delete” key on the keyboard. 

 

  

 

 

 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the imaging, 
there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The software measurement 
tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the measurement value depends on threshold 
values; thus, user must set proper thresholds to get the best estimate of  the desired structure. The measurements must not be 
used as the sole metric for any treatment. 

   

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or actual 
treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of  all measurement tools. Measurement accuracy depends on the image data and the hardware scanner 
that generated the image data. The measurement cannot be more precise than the resolution of  the image. Software reports the 
value based on user-picked points. Due to the nature of  medical imaging, the boundary is not always well defined. The apparent 
boundary depends on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to 
brightness and contrast. The user must understand the limitation of  the measurement value before applying to the patient. If  you 
notice any inconsistencies or software problems with measurements, or have further questions or concerns about using 
measurement tools correctly, please contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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Implant: Advanced Restoration Design 
TxSTUDIO features advanced restoration design functions located in the Restoration Tab (see the 
Restoration section for more information on this tab, pg. 78). Compatibility between files saved in different 
TxSTUDIO/Invivo5 versions will cause certain behavior that accommodates this new functionality, as 
described below: 
 
Scenario: 

1. Opening an INV file containing a restoration 
workup from any version prior to 5.3: 

Consequence: 
1. The Implant tab will display these restorations 

as they were last saved. Upon going to the 
Restoration Tab, however, the program will 
attempt to convert the original restorations 
into crowns from the new library. If  the user 
chooses not to convert the restorations (No), 
they will be brought back to the Implant Tab. 

 

 
 

 
2. Opening an INV file saved in TxSTUDIO 

5.3 with an implant and restoration workup 
in earlier versions of  TxSTUDIO/Invivo: 

 

 
2. The earlier versions of  TxSTUDIO will not 

be able to display the restoration crowns in 
the Implant or Model Tabs. 

3. Opening an INV file saved with implants 
from any earlier version, but no 
restorations: 

3. The implant workup will be loaded, and the 
user will be able to add restorations from the 
Restoration teeth library. 

Implant: Adding Restorations 
 
Restorations can be added directly to all the 
implants using the Add All button. A default 
restoration will be placed on each implant that does 
not yet have a restoration. The Remove All button 
will remove all the placed restorations. The Edit 
button will present the option to do further editing 
in the Restoration Tab. Locking the restorations to 
implant will automatically move the restorations 
when the implants are moved. Restorations may 
also be added, edited, or removed in the Restoration 
Tab (see Restoration section for more information, 
pg. 78). The Restoration Tab view is synchronized 
with the Implant Tab view for ease of  editing 
between the two tabs. 
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Implant: Check Sleeves 

 

The  Check Sleeves function can be performed to determine the position of  where sleeves would be if  a 
surgical guide was produced for implant placement. This function will simulate possible collisions that may occur 
between: 

 Sleeves and other sleeves 
 Sleeves and the instrument 
 Sleeves and the stone model 
 Instrument and the stone model 

Interference: Demonstrated visually by a dark red colored sphere. These interference indicators are not 
updated in real-time and will only be rechecked after each instance that Check Sleeves is performed.  
 

 
Check Sleeve Interference: The user can 
change certain preferences to simulate the 
actual procedure that will be performed 
better, such as sleeve system, instrument, 
sleeve size, and drill. Solution options are to 
change implant planning, change sleeve 
preferences, or to allow a technician to try 
to resolve the interference. 

 

The option to check sleeves will automatically appear when attempting to save Osteoid Surgical Guide 
planning files.  
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Implant: View Sequencer 

 

 

 The  implant view sequencer is a movie-creating tool that contains both an axial and buccal (shown 
above) preset sequence of  view positions and rotations.  

 The sequence is adapted to be used with any case and immediately played as a preview. 
 A movie file (.avi) that resembles the preview can be captured. 
 

 

 
 
View Sequencer 

 

 
 
 
Animation 

 Animate: Set the sequence to include the placement of  
implants, abutments, and restorations. 

 Clipping: Set the sequence to include the preset 
clipping actions. 

Camera 
 Orientation: Set the orientation to be axial or buccal. 
 Zoom: Set the zoom level of  the rendering window 

(None, 1.5X, 2.0X). 
View Sequence Player 

 Slider: Shows the current progress through the video 
while allowing navigation through the preview by 
clicking and dragging. 

 Stop: Stop the preview. 
 Play/Pause: Starts the video/pauses the 

video/resumes the video. 
 Playback speed: Speed of  playback (slow, medium, 

fast). 
 Frames per second: Sets the smoothness of  the 

preview playback. 
 Loop: Sets the preview to loop at the end of  playing 

the sequence. 
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Action 
The current view sequence will be captured into a movie 
file. 

Movie File Location 
Choose the location to save the file by clicking Change. 

Available Codecs Installed In This Computer 
Choose from a drop-down list of  the available codecs 
installed on the computer. Click Configure to choose 
from more recording options. 

Video Frames and Playing Time 
 Seconds/Implant: Length of  sequence for displaying 

each implant. 
 Frames/Sec: Smoothness of  the video. 
 Total Play Time: Calculates the total play time for the 

options selected. 
Ending Logo 

 Image File: Click Browse to select the location of  the 
logo file. 

 Add Logo: Select the checkbox to add in a logo 
segment to the movie. 

 Duration: Set the length of  time to show the logo. 
 Background: Set the background color for the logo 

segment. 
Capture 

Creates a video file from the selected sequence and video recording settings. Click Cancel to exit this 
dialog without recording the video. 
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Implant: Settings and Preferences 

Selecting the Preferences tool  opens up a customization window within the Implant Tab: 

 

Tooth ID System: 

You can set the ID to either the Universal or FDI(International) standard. 

Clipping Preference: 

Options for which models to include in volume clipping. 

Show Collision Warning: 

You can define whether or not to display a proximity warning between implants at an allowed tolerance. 

Rendering Method: 

Choose which rendering method (Default, Performance, and Quality) you would like to use in the Implant Tab. 

Color Control: 

Set the various colors for the abutment, restoration, and collision colors. 

Detailed Implant Settings: 

Adjust default settings for individual implants. See more information below. 

Preferred Implants Settings: 

Used to modify which implants will be displayed in the dropdown menus in the Control Panel. See more information 
in the Preferred Implant Settings section on page 76. 
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Detailed Implant Settings 

When you select Detailed Implant Settings, you are able to adjust the default settings for individual implants in the 
Implant Planning Preference Window. 

 

 

 
Clicking once anywhere in the 
region above will activate 
drop-down menus for the 
various implant characteristics. 
Options will not appear for implants 
not in the preferred list (see below).  

 

Click OK to save these preferences and the designated implant will be selected automatically when choosing a tooth in the 
Add Single Implant menu. 
Preferred Implants Settings 

The user can hide certain implants from populating the lists to simplify the drop-down menus. By default, all implant 
manufacturers and types are selected as “preferred.” To remove an implant, select it in the list on the right-
hand side and use the left arrow button to remove it from the list.  

 

Settings will take effect in the 
drop-down menu options for 
Detailed Implant Settings as 
well as in the Implant section of  
the Control Panel. If  there is a 
case open with implants that are 
not in the preferred list, the 
implant will still show up 
correctly in the renderers and 
the Control Panel. However, the 
specific settings for this implant 
cannot be changed and implants 
of  the same type cannot be 
added. 

Adding implants to the preferred list can be accomplished by selecting the implant manufacturer on the list on 
the left-hand side, selecting the specific product in the middle column, and pushing the right arrow button to add. 
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Certain manufacturers are divided into guided and non-guided subsets to indicate compatibility with the Osteoid 
Surgical Guide kits. 

Density Profile Control 

By selecting the Density Profile Control tool  you can adjust the settings for the Density Profile. 

 

 

Visible: Toggles the visibility between the Density Profile and the 
third cross section. 

H.U.: Shows the bone density in Hounsfield units. 

Bone Density: Shows the density in Misch’s bone density units. 

Thickness: Changes the sampled volume located around the implant. 

Apical Space: Changes the sampled volume located at the apex of  
the implant. 

Cell Size: Changes how finely the voxels will be sampled and 
displayed in the volume around the implant. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off  of  the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  the medical 
imaging, the boundary is not always well-defined. The apparent boundary depends on the current brightness and contrast 
setting. The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand 
the limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problem with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Osteoid support at (408) 333-3484 or 
email us at info@osteoidinc.com 
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Restoration View Features 
The Restoration View Tab is an advanced tool that bridges the gap between implantology and restoration crown design. Users can 
register the stone models and add on teeth directly or onto existing planned implants. With the model collision visibility options, numerous full 
teeth libraries, and mesh editing features, this tab aims to guide implant surgery toward perfect occlusion.  
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Restoration: Toolbar 
Shown below is the Toolbar and tools that are loaded with the Restoration View Tab: 

 

 
Reset View: Resets the rendering window to the original view size. 

 
Left View: Automatically orients the volume so the patient is facing left sagittal. 

 
Frontal View: Automatically orients the volume so the patient is facing the front. 

 
Right View: Automatically orients the volume so the patient is facing right sagittal. 

 
Top View: Automatically orients the volume so you are oriented above the patient. 

 
Bottom View: Automatically orients the volume so you are oriented below the patient. 

 

Distance Measurement: Select this option and mark two points on the volume and distance will 
appear. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. Control Panel features in Volume Render Tab allow the 
values to be projected to 2D, hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and angle between 
them will appear. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. Control Panel 
features in Volume Render Tab allow the values to be projected to 2D, hidden, or exported to a 
report. 

 

Show Collision: Turns on/off  the collision between teeth restorations and the opposing/working 
stone models or restorations. 

 
Show inter-arch collision: Turns on/off  the visibility of  collisions between the stone models. 

 
Area Drag: Turns on the area drag tool in the rendering and the single tooth renderer windows. 

 
Push Mesh: Turns on the push mesh tool in the rendering and the single tooth renderer windows. 

 
Pull Mesh: Turns on the pull mesh tool in the rendering and the single tooth renderer windows. 

 
Smooth: Turns on the smooth tool in the rendering and the single tooth renderer windows. 

 

Auto collision resolution: Turns on the auto collision tool in the rendering and the single tooth 
renderer windows. 

 

Plane Cutter: Activates a polygonal cutting tool to cut and close the mesh of  stone models in the 
rendering window. 

 
Cap Model: Applies a capping function to the available open mesh stone models. 

 

Tooth extraction: Enables a polygonal mesh cutting tool for use on a stone model in immediate 
extraction cases. 
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Adjust occlusion: Turns on the stone model adjustment widget for manually moving the stone 
models and their dependent restorations in the rendering window. 

 

Articulation: Opens the Articulation dialog to open/close the jaws with a simulated biting 
motion. 

 

Toggle Grid: Turns on/off  the 2D grid for simple assessment of  size, measurement, and spatial 
location. 

 
Change Layout: Toggles the rendering window layout. 

 

Preferences: Opens the Preferences dialog for selecting color, collision, and default tool size 
settings.  

 
Information Display: Displays or hides case information embedded in the data. 

 

Fit to Margin: Opens a dialog to adjust the interface between a restoration and a prepped tooth 
on the stone model. 

 
Custom Abutment: Opens a dialog that provides options for abutment design. 

 

Fit to Custom Abutment: Opens a dialog to adjust the interface between a restoration and a 
custom abutment. 

 

Create Pontic with Gingiva: Opens a dialog to modify the base of  a pontic to fit to or offset 
from the stone model. 

 

Create Bridge Connector between Selected Restorations: Creates a bridge linking all of  the 
selected restorations. This bridge group can be deleted and converted back into the individual 
restorations. 

 

  

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or actual 
treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements 
correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the image data and the 
hardware scanner that generated the image data. The measurement cannot be more precise than the resolution of  the 
image. Software reports the value based on user-picked points. Due to the nature of  the medical imaging, the boundary is 
not always well-defined. The apparent boundary depends on the current brightness and contrast setting. The boundary 
may shift as the user makes adjustments to brightness and contrast. The user must understand the limitation of  the 
measurement value before applying to the patient. If  you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly,  please contact us at (408) 
333-3484 or email us at info@osteoidinc.com 

  

 

Warning: Any implants and restorations that are incorrectly visualized in Restoration Design Studio may lead to surgical 
complications or treatment delays. If  you notice any inconsistencies or software problems with implant or restoration planning or 
have further questions or concerns, please contact Osteoid support at (408) 333-3484 or email us at info@osteoidinc.com 
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Restoration: Control Panel 

 

Import Stone Models 
Initiates a sequence of  steps to import and register a stone model. 
For more information, see the Restoration: Stone Model 
Registration section on page 82. 

Stone Model Registration 
Opens the Register Stone Models to Volume dialog to restart the 
registration for the imported stone models. 

Restoration Management 
 Add New…: Opens the teeth library for restoration 

selection and placement. 
 Edit…: Opens the teeth library to change the currently 

selected restoration. 
 Delete: Removes the currently selected restoration from the 

rendering window. 
Restoration Editing 

 M-D Size(mm): Adjusts the mesiodistal dimension of  the 
restoration. 

 B-L Size(mm): Adjusts the buccolingual dimension of  the 
restoration. 

 Height (mm): Adjust the height of  the restoration. 
 Cuspid: Adjusts the cusp dimensions from low to high. 

Visibility 
 Maxilla: Adjust the visibility/opacity of  the maxilla. 
 Mandible: Adjust the visibility/opacity of  the mandible. 
 Restoration: Adjusts the opacity of  the restorations. 
 Setup: Opens a dialog where the view presets can be 

configured. 
 Preset: Preset toggles that display the selected features as 

configured in the Setup. 
Collision 

 Teeth: Turns on the visibility of  collisions between the 
restorations and the opposing/working stone model or 
restorations. 

 Arch: Turns on the visibility of  collisions between the stone 
models. 

Volume 
 Brightness & Contrast: Can be adjusted for each of  the 

presets to enhance your image.  
 Visible: Turns on/off  the visibility of  the DCM volume. 
 Axial Clipping: Turns on/off  the axial clipping and the Axial 

Clipping widget. 
 Rendering (drop down): Chooses the rendering preset 

between the options of  Teeth and Bone. 
 Flip: Flips the clipping direction. 

Lock Implant to Restoration: When selected, the implant and restoration will move as a single unit. 
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Restoration: Stone Model Registration 
The Import Stone Model function will guide you step-
by-step through the importing and registration of  upper 
and lower stone models. If  stone models are already 
present in the workup, this function will serve to replace 
the existing models. 
Step 1: Import Stone Models 
 Click Import Stone Models in the Control Panel. 
 Choose the .stl or .ply file in the Select Stone Model 

File dialog. 
 Select the type of  model as Upper (maxilla) or Lower 

(mandible). 
 Move onto the next step. At the end of  registration, 

click Import Stone Models once more if  the 
opposing stone model needs to be imported or if  a 
stone model registration needs to be redone. 

 

 
Step 2: Select Type of Registration 
 Maintain Position: The software will apply the 

transformation data from the registration of  the 
opposing arch to this STL. This option is useful if  a 
pair of  STLs (upper and lower) have been registered 
in another program (intraoral scans may have close 
bite registration data). In this case, after registering 
one STL to the DCM (see Register to CT), the 
second STL can be imported and be loaded so that 
the close bite registration is restored. This will most 
likely result in an incorrect position relative to the 
DCM scan for the second STL, since many CBCT 
scans intended for implant/restorative workups are 
taken with open patient bites. 

 

 
 

 

 Register to CT: This will initiate the first step in 
registering the STL file to the DCM. The dialog 
(right, lower) shows the three steps needed to 
complete the registration. The layout (Figure 1) 
shows the STL on the left of  the rendering window 
and the DCM on the right with the adjacent clipping 
tool. Click Help to read the embedded document 
describing how to register different cases. 

o Clean Scan: Use on DCMs with low 
scatter in the dentulous regions. The 
point registration will use additional 
points where selected for a more 
accurate registration. 

o Restart: Resets the user back to Step 1 
in the dialog. 

o Perform Registration: Matches the 
STL to the DCM based on the points 
selected. 

 



 

ANA003 Rev G.  17 June 2022                                         Page 83 of 160                                                                       UM-TXS-ENG-54G 

o Done: Closes the dialog. 
 

 
Figure 1 

o After clicking Perform Registration, the user will be brought to a new layout 
(Figure 2), which features two volume renderers and three grayscale slice 
renderers. Use the yellow arrows in the DCM renderer to center the mid-point 
in the correct position at the front of  the scan. After verifying this point in 
the sagittal grayscale renderer, continue using the other widget arrows and 
slice renderers to rotate the STL around this mid-point and achieve the proper 
orientation. 

 

 

 
Figure 2 
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Restoration: Rendering Window & Mesh Manipulation 

 

Rendering Window:  
 Displays the stone models, restorations, DCM volume, implants, and skin models.  
 The restoration can be moved by first left-clicking to select the tooth and then left-clicking and dragging 

the model to a new location from any view. The angle in which the tooth is viewed determines on which 
plane the restoration will translate.  

 All the mesh editing functions except Auto collision resolution will function in this window. 
 Plane cutter, Cap model, Tooth extraction, Adjust occlusion, and Articulation can be performed 

in this window. 
 
Single Tooth Renderer: 
 The tooth model can be independently rotated and zoomed in this view. Clicking on the D (distal), M 

(mesial), B (buccal), or L (lingual) letters will move the restoration in short steps in the selected direction 
within the rendering window. 

 The tooth library type and tooth number will be displayed in the upper left. 
 The color scale at the bottom will indicate the depth of  the collision with the opposing stone model 

when Tooth collision is activated. The interval for depth(mm) is set to 0.1 to 2mm and can be changed 
in the Preferences.  

 All mesh editing functions including Auto collision resolution will function in this window. 
 
Occlusal Renderer (Maxilla and Mandible): 
 These renderers will display the STL models, restorations, and the collisions (depth or boundaries) 

between them. It is intended for viewing purposes and the models cannot be zoomed or rotated but 
opacity changes will take effect. 

 
  

Single Tooth 
Renderer 

Occlusal 
Renderer 
(Maxilla) 

 

Occlusal 
Renderer 

(Mandible) 
 

Rendering 
Window 
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Restoration: View Preset Setup 
Visibility presets allow for easy switching between set views during implant planning. To configure these settings, 
click on Setup. These presets may also be modified in the Implant Tab. 

 

 Edit Name: Click on any preset to select it. Type the 
new name into the field. 

 Visibility checkboxes hide or show features in the 
rendering window. 

 Implants: Toggles the visibility of  the implants. 
 Abutments: Toggles the visibility of  the abutments. 
 Skin: Toggles the visibility of  the face photo wrap 

from the Anatomodel workup file or 3DAnalysis. 

 Stonemodels: Controls the visibility of  the stone models. Varying degrees of  transparency can be 
obtained with the Opacity slider. 

 Restorations: Controls the visibility of  the 3D waxup models in the volume renderer and the colored 
profile in the 2D section renderer. The colored profile of  the selected restoration or restoration associated 
with the selected implant will be red while the unselected restorations will be pink. Varying degrees of  
transparency can be obtained with the Opacity slider. 

Volume: Controls the visibility of  the volume render as well as the rendering type.  
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Restoration: Abutment Planning 

 
 

 The abutment automatically connects the restoration model with the implant model in the rendering 
window.The currently selected abutment will be displayed enlarged on the right side. 

 

Restoration: Abutment Planning Dialog 
Abutment Parameters 

 

 

Top Shape 
 Height: Adjusts the length of  the abutment. 
 M-D Angle: Adjusts the mesiodistal angle. 
 B-L Angle: Adjusts the buccolingual angle. 
 M-D Size: Adjusts the mesiodistal size. 
 B-L Size: Adjusts the buccolingual size. 
 Rounding: Adjusts the rounding of  the abutment. 



 

ANA003 Rev G.  17 June 2022                                         Page 87 of 160                                                                       UM-TXS-ENG-54G 

 

Margin Shape 
 M-D Size: Adjusts the mesiodistal size. 
 B-L Size: Adjusts the buccolingual size. 
 Rounding: Adjusts the rounding of  the margin. 
 Shoulder: Adjusts the margin between the axial 

(abutment) tooth surface and finish line. 
 Extrude: Adjusts the size of  the finish line shape. 

 

Emergence Profile Shape 

 Top Curve: Adjusts the shape of  the upper portion 
of  the abutment base. 

 Bottom Curve: Adjusts the shape of  the lower 
portion of  the abutment base. 

 

 Screw Hole: Adds a screw hole that exits through 
the top and bottom of  the abutment. 

 Healing abutment: Replaces the current abutment 
with a healing abutment. 

 

 

 Adjust Hex Edit Angle: Inserts a new widget into 
the renderer to allow rotation of  the hex. 

 Finish Editing Hex Index Angle: Removes the 
widget from the renderer.  

 

 Delete Abutment: Removes the selected 
abutment. 

 Abutment Grouping: Opens a dialog where 
abutments can be grouped such that their insertion 
angles will be parallel. 
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Restoration: Crown Types 
Crowns for prepped teeth or custom abutments 

When using the Fit to Margin tool  or the Fit to Custom Abutment tool , the Build Crown dialog will 
appear. This dialog allows you to adjust the base of  the restoration to interface optimally with the prepped tooth or 
abutment. 

Cement Gap 

 Thickness (mm): The distance between the interior of  the 
restoration and the top surface of  the prepped tooth or 
abutment. 

 Distance To Margin (mm): The distance between the 
inner and outer edge of  the restoration at the shoulder. 

 

Undercut/Blockout 
 Show undercut regions: Highlights the undercut regions 

in red. 
 Blockout undercut regions: Removes undercut regions by 

adjusting the restoration. 
 Align Insertion Axis with Tooth: This option is only 

available for prepped teeth. Select the appropriate tooth 
to align the insertion axis of  the restoration. 

Restoration Border 
 Width (mm): Width of  the restoration border at the 

shoulder. 
 Angle (deg): Angle of  the restoration border. 
 Edge (mm): Length of  the edge of  the restoration border. 
 Height (mm): Height of  the restoration border. 
Enable Margin Editing: This option is only available for prepped teeth. Adjust the margin tracing around the 
prepped tooth. 

Build Crown: Calculates and updates the shape of  the restoration base. 

Cancel: Exits the dialog. 

 
Pontics 

Pontic restorations will sit a set distance above the stone model can either retain its original design shape or be fit to 
the stone model’s surface. Click to select the restoration of  interest and then click the Create Pontic with Gingiva 

tool . 
Offset from gingiva: Distance between the bottom of  the restoration and 
the stone model. 
Type: 

 Fitted: The bottom of  the restoration will be reshaped to fit the 
contour of  the stone model. 

 Scaled: The restoration size will be scaled such that the bottom is 
the appropriate offset distance from the stone model.  
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Bridges 
Select a set of  restorations by “Ctrl” + right-clicking each restoration. Click the Create Bridge Connectors 

between Selected Restorations tool  to create a bridge.  

 

Choose Yes to create a bridge for reduced crowns. This bridge 
will have editable connectors.  

Choose No to create a bridge that links the restorations but 
does not have connectors. 

Restorations cannot be manipulated individually or moved after bridge creation. 
If  a bridge for reduced crowns was created, each connector may be edited individually. Click on the connector to 
select it and open the Bridge Connector Options and display the editable nodes. 

Bridge Connector Options 
Cross Section Shape: Choose the shape of  the cross section of  the connector. 

End Diameter: Set the diameter of  the ends of  the connector that contact the 
adjacent restorations. 

Middle Diameter: Set the diameter of  the middle of  the connector. 

 

  

 

Warning: Incorrect crown fitting may cause inaccurate crown shape and positioning. This may lead to surgical complications or 
delays if  treatment planning. 
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Restoration: Articulation and Adjust Occlusion 
Articulation 
For best results, first adjust the occlusion using the 

Adjust Occlusion tool . The Articulation 
function will determine a closed-bite orientation 
for the two STL models and define an occlusal 
plane. The STL models can then be opened, 
closed, or slid across each other to simulate 
anatomical jaw operations. (The closed bite 
registration is determined by a best-fit of  the two 
STLs during specified interactions.) 
 
Activation of  this feature will turn on:  
 A widget for editing the position of  the 

condyles as well as displaying the occlusal 
plane. The condyle handles can be left-clicked 
and dragged to the correct positions. 

 The Articulation dialog box (below). 
 
Articulation Dialog 

 

 

Condyle Angle 
This determines the angle of  the plane below the occlusal plane 
on which the mandible STL will slide. (Example: if  the Condyle 
Angle is set to 0 deg, the mandible will slide on the occlusal 
plane.) 

Movements 
 Open/Close: Changes the angle of  “jaw” opening and 

degree of  rotation during the articulation animation. 
 Sliding on Occlusal: Slides the mandible along the occlusal 

plane with an adjusted angle determined by the Condyle 
Angle 

 Left Condyle Sliding: Slides the left condyle forward along 
the occlusal plane with an adjusted angle determined by the 
Condyle Angle. 

 Right Condyle Sliding: Slides the right condyle forward along 
the occlusal plane with an adjusted angle determined by the 
Condyle Angle. 

 Show Occlusal Plane: Displays the blue frame of  the occlusal 
plane in the rendering window. 

Close 
Closes the dialog box and returns the STLs and restorations to 
the original registered position. 
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Restoration: Preferences 

Selecting the Preferences tool  opens up a customization window within the Restoration Tab: 

 

Collision Depth Color Code 
 Min Depth: Sets the minimum mesh collision 

depth for detection and select the color 
corresponding to minimal collision. 

 Medium Depth: Sets the color corresponding to 
the medium level of  collision based on the 
depth range. 

 Max Depth: Sets the level of  collision detected 
as maximal and select the corresponding color. 

Other Settings 
 Restoration color: Sets the color of  the 

restorations. 
 Stone Model Color: Sets the stone model color 
 Grid Color: Sets the color of  the grid on the 

individual restoration renderer as well as the 
Toggle Grid tool. 

 Area Drag Outer Radius: Sets the default Area 
Drag tool’s outer radius of  effect. Area can still 
be adjusted using the mouse scroll wheel when 
the tool is in use. 

 Area Drag Inner/Outer Radius Difference: 
Defines the inner circle of  the Area Drag tool. 
The inner circle directly experiences drag 
whereas the area of  the outer circle gets 
subsequently deformed by the drag force. 

 
 

 Push Widget Radius: Sets the default Push Mesh tool’s radius of  effect. Area can still be adjusted using 
the mouse scroll wheel when the tool is in use. 

 Pull Widget Radius: Sets the default Pull Mesh tool’s radius of  effect. Area can still be adjusted using 
the mouse scroll wheel when the tool is in use. 

 Smooth Widget Radius: Sets the default Smooth tool’s radius of  effect. Area can still be adjusted using 
the mouse scroll wheel when the tool is in use. 

 Movement Step Size: Adjusts the amount the selected restoration moves using the arrow keys. 
Collision Settings 
 Off: Collision between the structures will not be shown. 
 Boundary: Shows only the boundary of  collision in blue. 
 Shows the depth of  collision in the range of  colors set in the Collision Depth Color Code section. 
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TMJ View Features 
In the TMJ View Tab you can view the TMJ region with two independent focal troughs allowing you to get cross sections of  each TMJ 
in one view, along with corresponding coronal and axial views. The TMJ View Tab also lets you see the TMJ in 3D volume renderings 
with automatic segmentation. 
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TMJ: Toolbar 
Shown below is the Toolbar and tools that are loaded with the TMJ View Tab: 

 

 

Reset View: Resets the rendering window to the original view. 

 

Create Arch Spline (Focal Trough): Select this tool to create or edit the arch spline. Left-click to 
place the first point and continue left-clicking along the arch. After you have marked your final 
point, right-click or double-click to finalize the arch spline. When modifying an existing arch spline, 
drag the control points to the desired positions. 

 

Arch Spline (Focal Trough) Ruler: Places ruler along the Arch Spline for easy reference. 

 

Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters will automatically display. 

 

Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click 
the last point to create an angle. A number in degrees will automatically display. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of  the desired 
area. Double-click or right-click to end the measurement. A number in millimeters squared will be 
automatically displayed. 

 

Layout: Creates a different layout to your preference. After clicking on the layout icon, a list a various 
layout options will appear. Click on the layout of  your preference to apply it. These options allow 
for different case workup images. In this window, you can also choose how many millimeters you 
want the cross section interval to be. If  you choose 1.0mm, for example, there will be a space of  
1.0mm between each cross section. 

 

Toggle Cursor Visibility: Conceals or displays cursors. 

 

Information Display: Displays or hides case information embedded in the data. 

 

Condyle Segment: Allows for automatic segmentation of  the condyle in 3D. 

 

Fossa Segment: Allows for automatic segmentation of  the mandibular fossa in 3D. 

 

Positioning #: Allows for a positioning grid to toggle on/off  the cross-sections. 

 

Arrow Notation: Allows an arrow to be drawn on the image. 

 

Circle Notation: Allows a circle to be drawn on the image. 

 

Text Notation: Allows text to be written and edited on the image. 

 

View Sequence: Allows for the creation of  custom camera sequences and AVI file movie 
capturing. Refer to the Volume Render View Sequence (p. 59) section for additional 
information and description. 

 

Slice Capture Mode: Opens the Slice Capture Manager to enable the capture of  slices or groups 
of  slices from a series of  cross sections. Requires the creation of  a slice group in the Report 
view (see Report: Group Management Creation, pg. 147, for details). 
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Rotate Focal Troughs: This function will rotate the focal troughs 90 degrees in opposite 
directions. Warning: Sequence direction depends on focal trough direction. Medial and lateral 
may be flipped if  the focal trough angle is in the opposite direction. 

 

HU Measurement: Allows for a calculation of  the HU value of  an area within a bounding box. 
The user can create multiple HU measurements on a single image. Measurement information 
is displayed next to the defined measurement area that the user creates, and the text can be 
repositioned by clicking and dragging the text box with the left-mouse button. The font color 
and size of  the measurement text can be changed using the Preference settings from the File 
menu. The HU measurement will also display the calculated area and standard deviation for 
the region chosen. 

 

 

 

  

 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off  of  the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  the medical 
imaging, the boundary is not always well-defined. The apparent boundary depends on the current brightness and 
contrast setting. The boundary may shift as the user makes adjustments to brightness and contrast. The user must 
understand the limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or 
software problems with measurements, or have further questions or concerns about using measurement tools correctly, 
please contact us at (408) 333-3484 or email us at info@osteoidinc.com 



 

ANA003 Rev G.  17 June 2022                                         Page 95 of 160                                                                       UM-TXS-ENG-54G 

TMJ: Control Panel 

 

Layout 
 “Screen” mode shows the rendering window in full size but 

not life size.  
 “Print Out”  mode shows the image in life size and allows 

you to capture and print in life size. 
 Change Layout: Lets you switch to different layout 

orientations. 

Vertical Range and Orientation 
Select “Adjust” to change the rendered volume range and 
orientation. 

Lateral Slices 
 “Width” allows you to change the width of  the slices. 
 “Interval” allows you to change the interval between the 

cross-sectional slices. 
 “Thickness” allows you to add multiple slices together for 

ray sum visualizations. 

Frontal 
 This lets you adjust the view visualizations of  the coronal 

slices of  the TMJ. 
o Slice – Gray Scale rendering 
o X-ray – X-ray rendering 
o Vol1 – Teeth rendering 
o Vol2 – Bone rendering 

 Using the Thickness drop-down, you can create a ray sum 
view. 

View Control 
 Brightness and Contrast allow you to adjust the image. 
 The “All” drop-down allows you to adjust brightness/contrast in different areas independently. 
 Color Presets can be used to view the images in different colors. 
 Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D slice 

renderers. 

Focal Trough 
Click on the “Symmetry” box to keep the focal trough angles symmetrical. 

HU Shape 
The shape of  the HU measurements can set to Rectangle, Circle, or Ellipse. Each shape is defined by two left-
mouse clicks and allows adjustments to the size to be made by first left-clicking to select the shape or 
measurement box and then left-clicking and dragging the red dots to adjust the position or size. 

Save View Settings 
Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 
section in Preferences for more information on which settings are saved for this specific tab.  
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TMJ: Rendering Window 

 

Please refer to Image Navigation (pg. 31) for information about controlling 
and adjusting these images. 
 

Arch Spline (Focal Trough) Navigation 
 

 Endpoints: Clicking and dragging either endpoint of  the focal trough can shorten/lengthen the focal 

trough or rotate the focal trough, depending on the direction that it is dragged.  

 
Warning: Sequence direction depends on the focal trough direction. Medial and lateral may be flipped if  the focal 
trough angle is in the opposite direction. 

 Cross Section Indicators: Clicking and dragging the stack of  green lines will scroll the cross sections 

through the focal trough in that direction. 

 Focal Trough Box: Clicking and dragging any one of  the lines forming the shape of  the focal trough 
will move the entire focal trough. 
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TMJ: Layout 
 

 
 
Many of  the various layout options of  the TMJ Tab feature frontal views of  the condyle. Some layout features 
include: 
 

 Two frontal volume views for each condyle, as seen above. 

 Free rotation of  the volumes after Vol1 or Vol2 have been activated. 

 Sculpting operations carry over from Volume Render: The condyles can be segmented out using 

sculpting tools in the Volume Render Tab. These operations are carried over automatically to the TMJ 

Tab. 
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Super Pano View Features 
The Super Pano View Tab gives you the ability to construct and view an enhanced version of  a panoramic radiograph, take 
measurements, and utilize several image enhancement features. It also has the ability to render a pano into a volumetric 3D image that can 
be rotated for greater visual advantages. 
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Super Pano: Toolbar 
Shown below is the Toolbar and tools that are loaded with the Super Pano View Tab: 

 

 

Reset View: Resets the rendering window to the original view. 

 

Create Focal Trough: Sets the boundaries of  the Super Pano. A focal trough is automatically set but 
can be adjusted or recreated entirely. Use the yellow dots to stretch, widen, or reshape the focal 
trough. The focal trough selects only the objects you want to appear in the Super Pano and excludes 
others such as the spine, which traditionally appears in panoramic radiographs as background 
noise. 

 

Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters will automatically display. 

 

Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click 
the last point to create an angle. A number in degrees will automatically display. 

 

Grid: Toggles between two different grid layouts for use in the all of  the section frames allowing quick 
assessment of  measurements and spatial location. 

 

Information Display: Displays or hides case information embedded in the data. 

 

  

 

 

  

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off  of  the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  the medical 
imaging, the boundary is not always well-defined. The apparent boundary depends on the current brightness and 
contrast setting. The boundary may shift as the user makes adjustments to brightness and contrast. The user must 
understand the limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or 
software problems with measurements, or have further questions or concerns about using measurement tools correctly, 
please contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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Super Pano: Control Panel 

 

Create Pano 
 The lower-upper limit is adjusted by left-clicking on a 

green line and dragging with the mouse. It specifies the 
vertical dimension of  the pano that is being created. 

 The focal trough is adjusted by left-clicking on the 
yellow points and dragging with the mouse. The length, 
width, and shape of  the focal trough are adjusted to 
specify what will appear in the pano. 

 A preview is also shown in the rendering window. 
 The Create Pano button should be pressed after the 

lower-upper limit and focal trough are first adjusted. 

Gray Scale Threshold 
 This threshold sets the density limit in the pano. 
 For noisy images, adjust the threshold so that the noise 

does not contribute to the pano. 
 Threshold is usually set slightly below bone density. 

View Controls 
 Pano can be rendered in multiple visualizations. 
 Enhanced Gray sharpens Gray Scale rendering. 
 By default, Enhanced Gray is selected. 
 Brightness & Contrast: Can be adjusted to enhance 

your image. 
 Inverse: Switches the background to white (switches 

coloring for Gray Scale Rendering). 
 Sharpening Filter: Applies the selected sharpening filter 

from the drop-down menu to the 2D slice renderers. 
 Tru-Pan™: This option enables the one-click 

volumetric pan that can be created from scans taken by 
a i-CAT© Cone Beam 3D system. See more 
information in the Tru-Pan™ section of  the manual. 

3D Settings 
 Enable 3D: Select this feature to render the Pano as a volumetric 3D image. The Pano can be rotated, 

clipped, etc. like other volumes (see Image Navigation, p. 31). 
 Quality: Select this to give the highest level of  detail for the generated Pano. 
 A traced nerve or placed implant can be toggled on/off  with the “Nerve” and “Implant” boxes. 
Clipping 

This option is only applicable when 3D Pano is available. Clipping hides some part of  the image so that 
the internal structure can be visible. 

Axial Setup 
The slice mode box lets you choose how the focal trough will be shown. 



 

ANA003 Rev G.  17 June 2022                                         Page 101 of 160                                                                       UM-TXS-ENG-54G 

Super Pano: Rendering Window 
Upper-Lower Limit: The lower left box where the vertical parameter of  the Super Pano is set. The green lines 
indicate the vertical limits. They can be dragged to set the desired upper and lower limit of  the Super Pano. When 
“Slice Mode” is selected, the red line indicates where the focal trough plane is and can also be adjusted. 

Focal Trough: The focal trough is adjusted in the lower middle box. Whatever is contained within it will appear in 
the Super Pano allowing the construction of  a panoramic x-ray with minimal background noise. The yellow dots 
can be left-clicked and dragged to adjust the length, width and shape of  the focal trough. The focal trough can be 
adjusted by dragging the focal trough control points, or a new trough can be created by clicking the trough icon on 
the toolbar. 

Preview: A preview of  the Super Pano will be displayed in the lower right box before actually creating it. This 
feature allows a Super Pano to be made more efficiently and with fewer or no adjustments needed afterwards. 

 
How to make a good Pano:  

 Make a U-shaped, narrow focal trough encompassing the arches by adjusting points on the focal 
trough. 

 Adjust Gray Scale threshold to filter soft tissue, so that the image is not too dark or too light. 
 Refer to Image Navigation (p. 31) for information about controlling and adjusting these images. 
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Super Ceph View Features 
The Super Ceph View Tab gives the ability to construct and view an enhanced version of  a cephalometric radiograph, take 
measurements, and utilize several image enhancement features, all of  which dramatically increases its diagnostic value. 
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Super Ceph: Toolbar 
Shown below is the Toolbar and tools that are loaded with the Super Ceph View Tab: 

 

 

Reset View: Resets the rendering window to the original view. 

 

Left View: Automatically orients the volume so the patient is facing left sagittal. 

 

Front View: Automatically orients the volume so that the patient is facing the front. 

 

Right View: Automatically orients the volume so the patient is facing right sagittal. 

 

Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters will automatically display. 

 

Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click 
the last point to create an angle. A number in degrees will automatically display. 

 

Grid: Toggles between two different grid layouts for use in the all of  the section frames allowing 
quick assessment of  measurements and spatial location. 

 

Information Display: Displays or hides case information embedded in the data. 

 

Change Layout: Toggles between different Super Ceph layouts. “Set Orientation” must be enabled 
to allow toggling between layouts. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or actual treatment is 
based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly and employ proper 
usage of  all measurement tools. Measurement accuracy depends on the image data and the hardware scanner that generated the image data. 
The measurement cannot be more precise than the resolution of  the image. Software reports the value based on user-picked points. Due 
to the nature of  medical imaging, the boundary is not always well defined. The apparent boundary depends on the current brightness and 
contrast setting. The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the limitation 
of  the measurement value before applying to the patient. If  you notice any inconsistencies or software problems with measurements, or 
have further questions or concerns about using measurement tools correctly, please contact us at (408) 333-3484 or email us at 
info@osteoidinc.com 
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Super Ceph: Control Panel 

 

Create Ceph 
 The Create Ceph button should only be clicked after 

the orientation of  the patient’s volumetric image is 
adjusted in the rendering window. 

 The “Set Orientation” box will reset the orientation if  a 
ceph was created incorrectly. Once the image is orientated 
correctly, press the Create Ceph button again. 

Layout: 
 “Screen” layout is optimized for viewing the image on 

the computer screen. “Print Out” layout is optimized 
for printing the image on paper. With Print Out layout, 
what you see on screen will be what you get on the 
paper in life-size. First, capture to Gallery, then print 
from Gallery to ensure the image is life size. 

Traditional Gray Scale Ceph 
 Brightness and Contrast can be adjusted to enhance 

your image. 
 The “Enhanced” box can be left-clicked on or off  to 

sharpen and enhance the quality of  the image. 
 Range Setup allows you to select which side of  the 

patient’s head the ceph will be created from. Thickness 
allows you to control how thick the range is. 

 When you change the Range Setup, you must recreate 
the ceph image using the Create Ceph button. 

 Sharpening Filter: Applies the selected sharpening filter 
from the drop-down menu to the 2D slice renderers. 

Volume Ceph 
 Increase the Opacity slider to superimpose the volume 

rendering onto the generated ceph. 
 Various enhanced views of  the ceph can be added; each 

has different advantages: 
 Bone highlights hard-tissue landmarks 
 Soft+Bone emphasizes the soft-tissue on the ceph 

Opacity, Brightness, and Contrast can all be adjusted 
for image enhancement. 

 Inverse switches the background to white (Gray Scale coloring switches black/white). 
 Range Setup allows you to select which side of  the patient’s head the ceph will be created from. 
 Projection allows you to switch from parallel views of  the cephalometric images to perspective 

views which resemble the magnification found in traditional cephalometric radiographs. 
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Super Ceph: Rendering Window 
This window is where the volumetric image of  the patient is orientated to create a ceph and is where the ceph will 
be viewed after creating it. 
 
Before clicking on the Create Ceph button in the Control Panel, the patient’s volumetric image must be correctly 
orientated. The easiest way to do this is to line up the left and right angles of  the mandible. If  the ceph is created 
with an improper orientation, it can be adjusted using the “Set Orientation” box in the Control Panel. 
 

 
 

Please refer to Image Navigation (pg. 31) for information about controlling 
and adjusting these images. 
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Super Ceph: Change Layout 
The default rendering layout for the Super Ceph tab is a five-volume view with a shared rendering preset. 
Each volume will initially be oriented at a different angle from the other volumes but can be rotated, 
panned, zoomed, or free-moved to a new orientation independent of  the other volumes. 
 

The user can switch to the Create Ceph layout by clicking the Change Layout button, . Switching back 
to the five-volume layout can be done by clicking once more on the Change Layout button when “Set 
Orientation” is enabled. (This will delete your current ceph, so it is recommended that you capture the ceph 
to the Gallery before selecting “Set Orientation.”) 
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Superimposition View Features 
In the Superimposition View Tab, you have the ability to open two different scans at once and view them side by side, and superimpose 
them. This is especially useful for assessing pre- and post-treatment scans. 
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Superimposition: Toolbar 
Shown below is the Tool Bar and tools that are loaded with the Superimposition View Tab: 

 

 

Reset View: Resets the rendering window to the original view size. 

 

Left View: Automatically orients the volume so the patient is facing left sagittal. 

 

Left ¾ View: Automatically orients the volume so the patient is facing 45° left sagittal. 

 

Front View: Automatically orients the volume so the patient is facing the front. 

 

Right ¾ View: Automatically orients the volume so the patient is facing 45° right sagittal. 

 

Right View: Automatically orients the volume so the patient is facing right sagittal. 

 

Top View: Automatically orients the volume so you are oriented above the patient. 

 

Bottom View: Automatically orients the volume so you are oriented below the patient. 

 

Back View: Automatically orients the volume to the posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume and distance will 
appear. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. Control Panel features in Volume Render Tab allow the 
values to be projected to 2D, hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle between 
them will appear. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. Control Panel 
features in Volume Render Tab allow the values to be projected to 2D, hidden, or exported to a 
report. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of  the desired 
area. Double-click or right-click to end the measurement. A number in millimeters squared will 
automatically be displayed. Control Panel features in Volume Render Tab allow the values to be 
projected to 2D, hidden, or exported to a report. 

 

Change Layout: Toggles the rendering window layout. 

 

Toggle Grid: Toggles between two different grid layouts for use in the upper two section frames 
allowing quick assessment of  measurements and spatial location. 

 

Registration: This icon is used to register the original volume to the second volume. Four or more 
anatomical points are chosen from each scan to properly align both scans at common, stable 
landmarks. 

 

Volume Registration: This icon is used to open the Volume Registration interface for automatic 
superimposed volume registration. Users will define a VOI (Volume of  Interest) Box as a reference 
for automated superimposition. 
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Adjust: This icon is used to make adjustments to better align the two volumes that are superimposed. 

 

3D Cursor: Toggles on/off  the cursor lines in the 3D volume rendering. 

 

 
   

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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Superimposition: Control Panel 

 

Superimposition Target: 
 Select Import New Volume to import a second 

volume. Superimpose either an Invivo file (.inv) or 
DICOM (.dcm) scan set. 

 Volumes will be registered to each other by selecting 
four or more landmarks on each volume using the 
Registration tool. 

 Select Mirror Own Volume to mirror the patient's 
anatomy to check for asymmetries. 

Original Volume and Superimposed: 
 Visible turns on/off  either volume independent of  

each other. 
 Preset allows you to choose different visualization 

presets for the volume. 
 Preset can also be selected independent of  each other. 
 The Brightness and Contrast in the volume renderings 

can be adjusted independently and improve the image. 

Clipping: 
 Select “Enable” to slice the image along predefined 

anatomical planes (sagittal, coronal, axial). 
 Select “Flip” to switch the view to the opposite side. 
 Control Clipping with the scroll mouse or slider. 

3D Volume Toggle: 
This slider allows you switch between the original volume 
and superimposed volume. Set the slider in the middle to 
visualize the both volume in equal opacity. Set the slider to 
one side to visualize only one image. 

2D Gray Scale Toggle: 
This slider allows you switch between the original gray scale 
slice and superimposed one. Set the slider in the middle to 
visualize the both in equal opacity. Set the slider to one side 
to visualize only one image. The Image Color box allows 
you to change the slice color. 

Visible: 
 Selectively control the visibility of  the implants, nerves, and models. 
 In Model Visibility, you can hide/show individual models in the rendering window. 

 
Save Superimposition: 

 This allows you to save the settings of  the Superimposition into an external file. 
 In the dialog that appears, choose where and what file name to save. 
 TxSTUDIO will save two files: .vdata and .odata 

o .vdata: stores the registration points and superimposed volume information 
o .odata: stores the original scan's volume orientation information 
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Load Superimposition: 
 This allows you to restore saved Superimposition. 
 Select Load Superimposition and choose the correct .vdata file. 
 The Superimposition file will be reloaded with the saved volume. 

Registration: 
“Limit Angle” will set limitations within the software during its registration calculations. If  you are 
experiencing inaccurate superimpositions after registering your points due to volume inversions, selecting 
Limit Angle may resolve some of  these issues. It is recommended that you attempt to use different or 
additional registration points if  this does not resolve the volume inversions. 
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Superimposition: How to Superimpose Two Volumes 
TxSTUDIO provides easy-to-use tools for superimposition. Although they are easy to use, superimposition is a 
technique-sensitive procedure with the most critical step being the registration of  the new scan via the selection of  
stable landmarks in both scans. This next sections discusses how to superimpose two scans step by step. 
 
Step 1: Open First File. Open the first file that you want to start with. You do not have to open them in any order, 
but starting with the pre-treatment scan may be recommended for sake of  organization. See DICOM and Invivo 
File Loading (p. 23) section if  you are unsure how to open an Invivo file with the software. 
 
Step 2: Import Volume. Go to the Superimposition Tab and from the Control Panel, click on the button labeled 
Import New Volume to select your second file to open. The File Manager will appear allowing you to open either 
a DICOM file or an Invivo file. 
 
Step 3: Press the Registration icon. It can be found in the Superimposition toolbar. 
 

 
 
Step 4: Registering the Two Scans to Each Other. In order to superimpose the scans correctly and precisely as 
possible, strict attention must be placed in selecting at least four matching and stable landmarks in both scans. 

 To select landmarks on each volume: 
o Press down on the center scroll-wheel of  the mouse. 
o Or, position the mouse over the landmark and press the space bar on the keyboard. 

 Select the first stable landmark on one scan using either method above. 
 Select the matching stable landmark on the other scan using either method above. 

o Each point shows up as either a blue or red dot. 
o Points are numbered for easy-reference. 

 The volume can be rotated using the left-mouse button as before. 
 The volume can be clipped by selecting Clipping: Enable in the Control Panel. 
 The volume rendering presets can be adjusted using the Preset button(s). 
 Use caution in setting your Brightness and Contrast settings. 

o Be sure the Brightness and Contrast settings for the original and imported volumes are 
similar 

o Be sure to use the similar Preset settings when registering points 
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The image above shows a registration point (Registration Point 1) located on the anterior point of  the right 
zygomaticofrontal suture. The point has been added to both the original scan (white, left) and the new scan (blue, right). 

 
 
Step 5: Save Points and Finish Registration. Once all points are plotted one by one, click the right-mouse button 
to register the two scans. It is recommended to practice by opening the same scan twice before trying to superimpose 
two different scans. You can see how precise you are by how much overlap there is between the two registered scans. 
 

  

(a) (b) 

(a) The above image on the left is of  two identical data sets that are registered to each other precisely. Notice 
there are no overlapping areas of  different colors. 

(b) The image on the right is of  two volumes not registered precisely. Notice the blue and white skeletal 
boundaries do not line up, and the presence of  double images. 
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Superimposition: Using Superimposition Aligner for Fine Adjustments 
After finishing the landmark registration, you can use the other tools provided in the Superimposition Toolbar to 
make final adjustments to your superimposition. 
 

 
To make the cross sections bigger, use the Change Layout icon from the Toolbar 

 
To move the volume manually, use the Adjust icon from the Toolbar to display the move widget 
on the superimposed volume 

 
The above tools are available for use prior to using the Landmark Selector; however, it is strongly recommended 
that you first use the Registration tool before using the Adjust tool. 
 
 
Check the cross-sections for accuracy by adjusting the Layout (Change Layout icon) and the 2D Gray Scale 
Toggle slider (View Controls). The superimposition is shown in 3D as well as in the cross sections. Make the 
necessary adjustments. 
 
 

 

For example, notice in the sagittal section shown to the 
left that the superimposed volume is not totally 
overlapped. Using the Adjust tool, move the volume in 
the anterior-posterior direction until the sections align by 
clicking on the yellow arrow in the move widget and 
dragging it forwards or backwards. 
 
 
 
 
 
 
One should go through each anatomical plane to check 
for precision. The cranial base should match up perfectly 
because it is stable; however, the vertebrae will usually be 
off  because the patient's head is always tilted somewhat 
differently in each scan. 
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Superimposition: Using Volume Registration for Fine Adjustments 
After finishing the landmark registration, you can use the other tools provided in the Superimposition Toolbar to 
make final adjustments to your superimposition. 
 

 
To make the cross sections bigger, use the Change Layout icon from the Toolbar 

 
To fine-tune the registered volumes, use the Volume Registration icon from the Toolbar to 
open the Volume Registration interface 

 
The above tools are available for use prior to using the Landmark Selector; however, it is strongly recommended 
that you first use the Registration tool before using the Volume Registration tool. 
 
 
Select the Volume Registration icon in the toolbar to open the Volume Registration interface. 
 
Left-click on any of  the 2D cross-sections to place the center of  the VOI (Volume of  Interest) Box. The VOI box 
can be moved at any time by clicking another location in one of  the 2D cross sections. 
 

 

Target Volume Size: 
 R-L Size: Defines the lateral width (mm) of  

the VOI Box. 
 A-P Size: Defines the anterior-posterior width 

(mm) of  the VOI Box. 
 H-F Size: Defines the inferior-superior height 

(mm) of  the VOI Box. 
 Press Update Size to show the updated VOI 

Box size in the rendering window. 

Select Perform Registration to run the automatic registration process for the VOI Box selected. The 
process time is based on your computer's hardware components; however, in general, the larger the VOI Box, 
the more time is required to complete the automatic registration. 
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The following images show the VOI Box applied around the cranial base of  a pre- and post-surgery 
superimposed scan (top image) and the results of  the automatic registration process (bottom image). 
Notice that the two cranial base profiles line up exactly following the automatic registration process. The VOI 
Box used is the default (x, y, z) = 50mm x 50mm x 40mm. 
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Superimposition: Difference Between .vdata Files and .odata Files 
After you have successfully registered a different scan to your original volume data, TxSTUDIO allows you to save 
the Superimposition data using the Save Superimposition button. This section looks to further define the 
difference between the output files (.vdata and .odata) and how to use them. 
 
.vdata 

Information stored in the .vdata file includes the registration points and the path for finding your superimposed 
scan data. When you re-open your original scan, in the Superimposition Tab, press the Load Superimposition 
button and load the desired .vdata file. This will allow you to look at the Superimposed image without having 
to re-register your landmarks. 

 
.odata 

Information stored in the .odata file includes the orientation information of  your original scan data (not your 
Superimposed scan). With this information, you can set specific orientations for other cases as well. 
 
To import a new orientation, go to File in the Menu Bar and select “Import Orientation.” Choose your desired 
.odata file and your case will automatically reorient itself. 
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Gallery View Features 
In the Gallery View Tab you can retrieve images that have been captured. Additionally, images can be imported or exported to the 
location of  your choice. Comments or notes can be added to describe images that have been captured. 
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Gallery: Toolbar 
Shown below is the Tool Bar and tools that are loaded with the Gallery View Tab: 

 

 
Crop Image: Allows you to crop and save the image that was captured. 

 

Gallery: Control Panel 

 

Images: Gives a list of  all captured images.  

 Each of  these images has a “Name” and “Type” which can be 
renamed by double-clicking on the text. 

 Move Up/Down: Moves the selected image up or down on the 
list. 

 Crop Current: Allows you to crop the currently selected image 
within Invivo. 

Image Operation  

 All/Selected: Applies operation to all or a subset of  the images 
from the list. 

 Remove: Removes images from the Gallery. 
 Export: Allows you to export the images in the Image List to 

a path specified in the dialog box that opens. Files can be saved 
as one of  the following formats: .jpg, .bmp, or .png. 

 Email: Captures all images to your email ready to send. This 
requires having a mailer client set up. 

Import Images: 

 Select to import images (.jpg, .bmp, .png) from an external 
source into the Gallery Tab. 

 Using this, you can import patient photographs into the Invivo 
software for storage within the Invivo file once saved. 

Comments: 

 Text box displays comments about the image displayed in the 
rendering window. 

 Add or change comments by editing the text in the Comments 
Box. 

2D Image Options: 

 Controls settings for 2D images. See more information in 
Gallery: 2D Image Options. 
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Gallery: Rendering Window 
This window allows the viewing of  captured and imported images. The Gallery is particularly useful for creating a 
workup of  a particular case. Remember that the Gallery’s images will only be saved if  you re-save the whole file; 
otherwise, any images captured will be lost. 

 

 
 

Please refer to Image Navigation (pg. 31) for information about controlling 
and adjusting these images. 
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Gallery: Adding Images to the Gallery 
Capture any single image to the Gallery. A single image within any view can be captured without including the 
other parts of  the rendering window. When the Capture to Gallery function is used, a dialog will appear on 
the screen providing the user with options regarding which parts of  the rendering window to capture.  
 
The options provided by each dialog will vary according to which TxSTUDIO tab is currently displayed; the 
following example is the dialog that appears within the ArchSection Tab: 
 

 
Ex. ArchSection Capture to Gallery 

Capture to Gallery Dialog: 

 Whole View – Captures a screenshot of  the 
rendering window 

 Axial – Captures the axial slice view and no 
other parts of  the rendering window 

 Pano – Captures the pano view and no other 
parts of  the rendering window 

 Cross Sections – Captures a series of  slices 
that are within the rendering window 

 
 
Options within each Image to Capture Dialog: 

Note: Some options will appear gray (disabled) in the Select Image to Capture dialog. The choices available 
are determined by the specific layout as well as the view tab. 

 

Section  Whole View 
 Axial, Coronal, Sagittal Slices 
 Cross (Displays Custom Cross Section or 3D Volume) 

Volume Rendering No Dialog 

ArchSection Whole View 
Axial 

Pano 
Cross Sections 

Implant Whole View 
Main Volume 
Axial 
Cross 
Density 

Para Arch 
Pano 
Arch Volume 
Front Volume 

TMJ Whole View 
Axial 
Left Pano 

Left Cross Section 
Right Pano 
Right Cross Sections 

SuperPano Whole View 
Pano 
Front Volume 

Axial 
Preview Pano 

SuperCeph No Dialog 
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SuperImposition Whole View 
Main Volume 
Axial 

Coronal 
Sagittal 
Imposed Volume 

Model Normal Layout No Dialog 

Occlusal Layout Whole View 
Lower Occlusional 
Upper Occlusional 

Composite Layout Whole View 
Composite 1-9 

 
 
Capture to Gallery Dialog: 

 

 Name: Image label 
Note: Image name must be unique from any 
other captured image in the Gallery and must 
not contain any special characters. 
 

 Type: Image type – can be set from the 
pull down to “Captured” or “Photo.” 
 

 Comments: Additional comments 
about the image can be added in this 
section. 
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Gallery: 2D Image Options 
The Gallery Tab is compatible with 2D DICOM images and has several features that allow it to handle this image 
format better. 

Opening 2D DICOM 

When instructed to open a 2D DICOM image, TxSTUDIO will automatically enter a mode that disables 
3D functionality. Only the Gallery tab will be available within the software and the DICOM will appear 
as a Gallery image. 
 
If  a 2D DICOM is associated with a 3D volume as a scout image, opening the volume will automatically 
import that scout image into the Gallery Tab. 
 

 
Grayscale Image Options 
 

For grayscale images in the Gallery, the user has the 
option to adjust several settings such as Gray Scale 
Threshold, Brightness, Contrast, and Sharpening.  
 
The updates to these images are saved and always 
reflect the updated settings when the image is selected 
in the Gallery and also after it has been 
saved/exported and then opened/imported back into 
Invivo.   
 
 

 

 
Export to DCM/JPG/PNG/TIF/BMP 
 

An image in the Gallery can be exported into any of  
the above formats when using the Export… button. 
When saving individual Gallery images to file, the 
following image formats will be available (JPG, 
PNG, BMP).  
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Model View Features 
The Model View Tab is where you can view your patient's AnatoModel or 3D photograph and simulate surgical or orthodontic 
simulations, as well as 3D soft tissue predictions. An AnatoModel is a 3D digital study model that is created by Osteoid via a case-by-case 
service. The DICOM data of  the patient is sent to Osteoid where it is modeled to create the most advanced digital study model available. 
This is because the AnatoModel contains anatomy such as roots, developing teeth, impactions, alveolar bone, and so on, while other models 
just show the crowns of  teeth. The 3D photograph service that Osteoid offers is viewed here too. Osteoid developed the technology to combine 
one frontal photo of  the patient and the patient's CT scan, to create a 3D model that overlays the scan data. 

Any nerve tracings, implant planning, or superimposition placing that has been done will also be visible in the Model Tab. Each item can be 
turned on/off  independently to see how all these systems come together with the volume data. 

 

For additional information about the AnatoModel service, please contact Osteoid at (408) 333-3484 or email us at 
info@osteoidinc.com. 
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Model: Toolbar 
Shown below is the Toolbar and tools that are loaded with the Model View Tab: 

 

 

Reset View: Resets the rendering window to the original view size. 

 

Left View: Automatically orients the volume so the patient is facing left sagittal. 

 

Left ¾ View: Automatically orients the volume so the patient is facing 45° left sagittal. 

 

Frontal View: Automatically orients the volume so the patient is facing the front. 

 

Right ¾ View: Automatically orients the volume so the patient is facing 45° right sagittal. 

 

Right View: Automatically orients the volume so the patient is facing right sagittal. 

 

Top View: Automatically orients the volume so you are oriented above the patient. 

 

Bottom View: Automatically orients the volume so you are oriented below the patient. 

 

Back View: Automatically orients the volume to the posterior view. 

 

Quick Slice: Once activated, clicking on a point on the volume will open a 2D zoom window in that 
location. The zoom window can be scrolled through using the mouse wheel. 

 

Marker: When selected you may mark a point on the volume and X,Y,Z coordinates (transverse, sagittal, 
vertical) will appear. Clicking on the point and moving the cursor can modify points. Click on the 
point and press the “delete” key to delete it. 

 

Distance Measurement: Select this option and mark two points on the volume and distance will 
appear. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. Control Panel features allow the values to be projected to 2D, 
hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle between 
them will appear. Clicking on their control points and moving the cursor can modify measurements. 
Click on the measurement and press the “delete” key to delete it. Control Panel features in Volume 
Render Tab allow the values to be projected to 2D, hidden, or exported to a report. 

 

Polygonal Measurement: After selecting this tool, click multiple points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared 
will automatically be displayed. Control Panel features in Volume Render Tab allow the values to be 
projected to 2D, hidden, or exported to a report. 

 

Toggle Grid: Toggles between four different grid layouts for simple assessment of  size, measurement, 
and spatial location. 

 

Information Display: Displays or hides case information embedded in the data. 
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View Sequence: Allows for the creation of  custom camera sequences for movie capturing. Refer to 
the Volume Render Tab: View Sequence (p. 59) section for additional information and 
description. 

 

Background: Allows for the background color to be changed. 

 

Setup View: Allows option to view either parallel or perspective views in 3D. You can change the 
annotation layout options under the Setup View. 

 

Comment Marker: Pick a point in the volume and enter comments. Enter the text you would like to 
appear in the Insert Comment window and press OK. 

 

  

  

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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Model: Control Panel 

 

Layout:  
 Normal shows the digital models in the normal patient 

orientation along with the volume rendering if  desired. 
 Occlusal shows both arches from the occlusal perspective. 
 Composite shows a composite of  multiple views of  the 

model all at once. 

Models: 
 Models: The individual, digital models (implants, nerves, 

teeth, superimposition) can be turned on or off  in the 
rendering window.  

 Skin Opacity: Controls the opacity of  the Skin model 
from the Anatomodel service or from 3DAnalysis. 

 Jaw Opacity: Controls the opacity of  the alveolar bone/ 
ABO base from the Anatomodel service. 

 The Airway checkbox toggles the visibility of  the airway 
measurement if  one has been generated in Section Tab 
or Volume Render Tab. 

 Show All and Hide All toggle the visibility of  all the 
listed models. 

 Settings: Control settings for items in the Models list. A 
model must first be selected in this list before the button 
is pressed. 

Volume 
 Select “Visible” to toggle the volume rendering on or off  

with the digital models. 
 The View Change button allows volume rendering 

options, such as Soft Tissue, Teeth, etc.  
 The Brightness and Contrast of  the images can be 

adjusted with the slider. 

Clipping 
 Select “Enable” to slice the image along the predefined 

anatomical planes (sagittal, axial, coronal). Control the 
clipping with the scroll mouse or the slider. 

 To switch a view to the opposite side, click “Flip.” 

Presets: 
 Preset toggles that display predetermined views. A custom view can also be set. 

Simulation: 
 Select either the TeethMovement or JawArticulation simulations, or press Edit to create a new 

simulation. 
 Move the slide bar to the right to indicate the ending point. 
 Click on a digital model to move it (either individual teeth or whole arches) with the move widget. 
 After the final position is reached using the 3D move widget, press Start to go back to frame one. 
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 Press Play to view your simulated movement. 
 Manage Keyframes lists the frames that compose the simulation for the selected model. (See page 

131.) 
 Press Soft Tissue Prediction to create a simulation of  the soft-tissue prediction. This is only 

possible with the use of  a 3D Photograph and Skin AnatoModel. 

Annotation: 
 Controls the visibility of  comment markers in the rendering window. 

 
  

 

Warning:  Soft tissue prediction is an approximation and may not reflect actual results. 
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Model: Rendering Window 

 

This window allows the viewing of  AnatoModels, 3D photographs, and simulation, all of  which are services that must be ordered per 
case for this feature to work. These services provide excellent diagnostic data and case presentation material. 

 
Please refer to Image Navigation (pg. 31) for information about controlling 
and adjusting these images.  
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Model: Custom Preset Setup 
Visibility presets allow for easy switching between set views. The Custom option is set manually by the user. To 
configure these settings, click on Set Custom. 

 

 Visibility checkboxes hide or show features in the 
rendering window. 

 Skin Opacity: Controls the visibility of  the face photo 
wrap from the Anatomodel workup file or 3DAnalysis. 
Varying degrees of  transparency can be obtained with 
the slider. 

 Jaw Opacity: Controls the visibility of  the jaw models. 
Varying degrees of  transparency can be obtained with 
the slider. 
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Model: Simulations 
Simulations may be created using any of  the model objects in the software, such as implants and restorations, as 
well as models created by the AnatoM odel service. 

 

 Adding and Deleting Simulations 
 Click Edit to open a list of  all simulations. 
 In the Name field, input the name of  the new simulation and click 

Add. The new simulation will appear on the list. 
 To delete a simulation, click on the simulation on the list to select 

it, then click Delete Selected. 
 Initial Selected sets the current view state as Frame 0 for the 

selected simulation. 
 If  “Edit 0 Frame” is checked, then the initial frame of  the 

simulation will be editable. 

 

 Creating Simulations 
 Move the slider to Frame 100. This will be the end state of  the 

model. 
 Select a model and the move widget should appear.  
 Use the move widget to adjust the final position of  the model. 
 Moving the slider (Frame 0 to 100) will move the model between 

the initial and final positions. 
 To adjust intermediate model positions, move the slider to an 

intermediate frame (between Frame 0 and 100). Use the move 
widget to adjust the model position. 

 Moving the slider (Frame 0 to 100) will move the model from the 
initial position, through intermediate positions, and to the final 
position. 

 

 Managing Keyframes 
 Any animation frame in which a model position was adjusted 

becomes a keyframe. 
 Keyframe management allows for preexisting keyframes to be 

easily identified, edited, or deleted as well as the creation of  new 
keyframes. 

 Click on Manage Keyframes to display a list of  the keyframes for 
the selected model. 

 The position of  the model at existing keyframes can be edited by 
selecting the appropriate frame and repositioning the model. 

 To insert keyframes, move the slider to the desired frame number 
and then click Insert. The model may then be moved to create a 
new state for that frame. 

 To delete keyframes, click on the keyframe on the list and then 
click Delete. 

 Note: Manage Keyframes does not apply to skinwrap. 
Please see page 135 for more information on Anatomodels and simulations. 
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Common How To Tasks 
How to Trace a Nerve 

 Go to the ArchSection Tab. 

 Make sure the pano is in Slice Mode (not X-ray mode). 

 Adjust focal trough such that the nerve pathway is visible in pano image. 

 Move pointer to the pano image. 

 Review the nerve pathway while using scroll wheel.  

 If  the nerve pathway is not clearly visible, adjust the focal trough. 

 When the nerve pathway is identified through the pano image, press New Nerve in the Control Panel. 

 Starting from the mandibular foramen, click point by point. 

 If  the nerve is not clearly visible, use the mouse scroll wheel to find the nerve and continue picking. 

 Near the mental foramen, move the mouse to cross-section view. 

 Use the scroll wheel to find the exit of  the nerve. 

 Pick points connecting the nerve exit. 

 Press Done in the Control Panel to finish the nerve. 

 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of  the nerve can lead to surgical 
complications if  diagnosis, treatment plans and/or actual treatment is based off  of  the incorrect tracing. It is critical for 
the end user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software 
problem with nerve tracing or have further questions or concerns about nerve tracing, please contact Osteoid support 
at (408) 333-3484 or email us at info@osteoidinc.com 
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How to Create Reports In Life Size 

 Go to ArchSection Tab. 
 Check “Adjust” in Vertical Range and Orientation. 
 Adjust upper and lower limit by dragging green lines and then un-check Adjust. 
 Adjust focal trough (arch spline) or re-draw arch spline by the clicking the Create Arch Spline 

button. 
 Change Layout Mode to “Print Out.” 
 Change to a desired layout using the Change Layout button. 
 Adjust cross-sectional width and interval. 
 Move cursor to set cross section in desired location. 
 In Print Out mode, user cannot zoom the image since it is set to life size. 
 If  desired structure is not visible in cross section, adjust axial cursor or focal trough. 
 Switch pano image to X-ray mode and turn on the ruler. 
 Turn on the Arch Spline Ruler and turn off  arch spline control points. 
 Turn off  the cursor if  necessary. 
 Go to the View menu and choose “Capture to Gallery.” 
 Go to Gallery Tab. 
 See Print Preview in the File menu and print out a test page. 
 If  you want to change the format, go to “Print Layout Setup” in the File Menu. 
 If  you want to use your own logo, replace the “printLogo.bmp” file in installation folder. This folder 

is typically in “C:\Program Files(x86)\Anatomage\InVivoDental” 
 After the Print Layout Setup is changed, make sure you choose Print Out mode before recapturing 

the image. Otherwise the image could still be in the previous Print Layout Setup. 
Other View Tabs with Life-Size Printing 

 Non-whole view, full-screen Section render (double-click a renderer to make full screen) 
 TMJ in Print Out mode (Axial slice will not be life-size) 
 Pano in Super Pano 
 Super Ceph in Print Out mode 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@osteoidinc.com 
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How to Create a Positive Airway View 

 Go to Volume Render Tab. 

 Select the Inverse preset. 

 Reduce the opacity such that the internal structures start to appear. 

 Change the viewpoint to Top View (Press Top View button in toolbar). 

 Use sculpting tool to remove the undesired parts. 

 Change the viewpoint and repeat sculpting operations. 

 After the desired airway is isolated, increase the opacity. 

 Adjust Brightness and Contrast to set the right visualization. 

 (The Airway Measurement tool also shows a positive airway view that is color coded based on area. This 

inverse method lets you see the airway without color coding.) 
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How to Create an AnatoModel Simulation and Video 
Simulations require the use of  the AnatoModel service provided on a case-by-case basis from Osteoid. The AnatoModel service may 
include some or all of  the following features: 

 Individually segmented, digital models of  patient dentition 
 Segmented digital models of  patient mandible and maxilla 
 3D photograph overlayed onto patient soft-tissue profile 

For additional information about the AnatoModel service, please contact Osteoid at (408) 333-3484 or email us at 
info@osteoidinc.com. 

 Go to Model Tab. 
 Control Panel: Simulation, from the drop-

down menu choose an existing Simulation 
(TeethMovement, JawArticulation) or 
create your own (select Edit). 

 Move the slider to the very end (Frame 
100).  

 

 Select a model adjust and the move widget should appear.  
 Use the move widget to adjust the final position of  the model. 
 Moving the slide bar (Frame 0 to 100) will move the model between the initial and final positions. 
 To adjust intermediate model positions, move the slide bar to an intermediate frame (between Frame 0 

and 100). Use the move widget to adjust the model position. 
 Moving the slide bar (Frame 0 to 100) will move the model from the initial position, through 

intermediate positions, and to the final position. 
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 View Sequence: 
 To create a video of  your simulation, select the View 

Sequence button from the Model Toolbar to open 
the View Sequencer Window. 

 Much like the Volume Render View Tab (pg. 59), 
you can insert scenes with various volume 
orientations, clippings, colorizations, etc. 

 Adjust rendering window image to desired settings 
(orientation, volume colorization, etc.) and move the 
Simulation slider to Frame 0. 

 Press Insert in View Sequencer window. 
 Adjust rendering window image to desired settings 

(orientation, volume colorization, etc.) and move the 
simulation slider to Frame 100. 

 Press Insert in View Sequencer window. 
 Test the video using the Start, Play/Pause and End 

buttons in the View Sequencer window. 

 

Movie Capture: 
 If  you are unsatisfied with the test video and view 

sequence, make the necessary changes (Insert new 
views or Modify/Delete existing views). 

 If  you are satisfied with the test video and view 
sequence, select VIDEO Capture to open the Movie 
Capture Window. 

 Please refer to Volume Render View Tab: View 
Sequence Section (pg. 59) for additional 
descriptions. 

 Capture the view sequence to save your simulation 
as an AVI movie file. 

 

 

  



 

ANA003 Rev G.  17 June 2022                                         Page 137 of 160                                                                       UM-TXS-ENG-54G 

Report Module Features 
The Report View Tab allows the creation of  templates containing images and text. A template can be applied to any case using this 
tab. In this picture, the page background is black so the black rectangle represents the page. Several types of  items can be placed within this 
page to create a detailed report for the patient. 
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Report: Toolbar 
Shown below is the Toolbar and tools that are loaded with the Report View Tab: 

 

 
Add Image: Adds a control to add a single image. 

 
Add Slices: Adds a control to add single slices or a group of  slices. 

 
Add Text: Adds a control to add text. 

 
First Page: Navigates to the first page of  the report. 

 
Previous Page: Navigates one page back. 

 
Next Page: Navigates one page forward. 

 
Last Page: Navigates to the last page of  the report. 

 
Insert Page: Inserts a page after the current page. 

 
New Page: Adds a page to the end of  your report. 

 
Remove Page: Deletes the current page. 

 
New Template: Creates a blank template. 

 
Export PDF: Saves the report as a PDF file. 

 

Export to PACS: Saves the report as a DICOM onto the PACS server. Requires PACS configuration 
beforehand. 

 

Preferences: Opens preferences for default colors, default image type, default page setup, grid 
alignment, and the template save path. 
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Report: Control Panel 

 

Template 

 Template drop-down: Lists the available templates. 
 Manage…: Displays all of  the preset templates. 

Templates can also be loaded, renamed, and removed 
in this dialog. See pg. 153. 

 Save…: Saves the current template. Templates are 
stored locally and show up on the drop-down. 

Add New Control 

Text: 
 Edit Phrases…: Opens a dialog for managing 

common phrases to be added to text controls. See pg. 
143. 

 Add Text: Adds a control for text. 
 Slice Group: 

 Slice Group Management: Allows creation and 
management of  image groups. 

 Add Slice Group: Adds a control for 2D slices. 
 Single Image: 

 Add Single Image: Adds a control for one image. 

Current Control 

 Name drop-down: Shows the name of  the currently 
selected control from a list of  controls on this page. 
Each control can be selected from the drop-down 
menu instead of  clicking the control. 

 Image Refresh: Updates the image according to the 
changes in the source image. 

 Properties: Opens the Properties window for the 
current control. 

 To Background: Puts the selected image behind 
other images. 

 To Foreground: Puts the selected image in front of  
other images. 

Page Control 
 Print Page: Enables the current page to be printed. 
 Page Setup: Opens page setup to allow you to set 

printer, paper size, margins, and background/border 
properties of  the page. 

 Page Information is displayed showing the current settings. 
Previous/Next Page: Page navigation controls. 

 Delete Page: Removes the current page. 
 Insert Page: Inserts a page after the current page. 
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Report: Rendering Window 

 
The rendering window displays the report page and is the main area for designing and viewing reports and 
templates. The page navigation buttons in the toolbar allow the user to switch between pages in a multi-page 
report to determine which is to be displayed in the rendering window. 
 
Adjusting the position and zoom of  the report within the rendering window uses the same keyboard and 
mouse button combinations as in other TxSTUDIO tabs: 
 

 Zoom – Ctrl + Left Click + Drag Mouse 
 Pan – Shift + Left Click + Drag Mouse 

 
For additional keyboard and mouse shortcuts relating to the Report View, see the section Full Screen and 
Keyboard Shortcuts (pg. 34).  
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Report: Adding Text Controls 
Controls are boxes that display text or image data. 

 

Adding and Sizing 

 Navigate the mouse cursor to the Control Panel 
on the left and select the button labeled Add 
Text, Add Slice Group, or Add Single Image. 

 Size the control: The image at the left shows the 
rectangle during creation. The control is created 
by two separate points and will not show up until 
the first point has been placed.  
 

 

Warning: If  you create the control outside 
the page, you will receive an error message 
and the control will not be created. 

 

 

 
 

 

Resizing and Customization 

 After successful creation of  the control, it will 
look like the image on the left. 

 Resize the control: Click and drag the green 
squares or the borders. Alternatively, set the 
height and width from the Properties window. 

 Move the control: Click and drag with the left 
mouse button or use the arrow keys on your 
keyboard after clicking inside the control. 

 Select a control: Click on the control or select it 
from the Name drop-down on the Control Panel. 
Pressing the Delete key will delete the control. To 
see the control's properties, press the Properties 
button while it is selected. Double-clicking the 
control also shows its properties. 

 Select multiple controls: Click more than one 
control while holding the “Ctrl” key on the 
keyboard. Supported multi-control operations are 
movement and deletion. 

 Copy and paste controls: Select a control, press 
Ctrl + C, then press Ctrl + V to paste it at another 
location. 
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Report: Adding Text Controls 
Text Controls contain text that is manually typed in or drawn from the Case Info. 

Adding a Text Control: 
 Click the Add Text button. 
 Properties can be changed by clicking Properties in the Current Control section of  the Control Panel. 

 

Text Box Dialog 
This dialog can be opened by double-clicking on a 
text control or selecting the control and clicking 
Properties on the Control Panel. 

Text 
 Alignment type: Select the text alignment type. 
 Font Options: Family, size, color, alignment, 

bold, and italics can be changed. 
 Text Input Box: Enter text to be displayed in 

this text box. 
 Insert Case Info: Inserts the selected data 

based on the case information or Gallery 
comments where the cursor is in the Text Input 
Box. 

 Insert Text Phrase: Inserts the selected text 
phrase where the cursor is in the Text Input 
Box. 

 Edit Phrases: Opens the Text Phrases dialog 
(See pg. 143). 

 

Box 
 Size and color: Determines the size of  the text 

control. Unchecking “Transparent” will show 
the chosen color instead of  the report’s 
background color. 

 Border: Set the border style, color, and 
thickness. Style can be dashed, solid, or none 
(not displayed). 

 

Save As 
 Choose the name of  the control. 

Show on Every Page 
 Check this option to show the text in the control 

on every page of  the template. 
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Text Phrases 
Text phrases allow you to store common phrases 
within the software and insert them into text 
controls. This dialog can be opened by click on 
Edit Phrases. 
 Search: Searches for the term in the list of  

stored phrases. 
 Add: Opens a dialog for creating a new phrase. 
 Edit: Opens a dialog for editing the selected 

phrase. 
 Remove: Removes the selected phrase. 
 Insert: Inserts the selected phrase into the text 

control. 
 Text Input: If  a text control is selected, type 

directly into the box to update the text control 
on the report. 
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Report: Slice Group Management 
Groups are created in the Report Tab and used in slice controls. The groups are populated from 
ArchSection and TMJ Tabs only. 
 

 
 
 
 
 
 

 

Slice Group Management: To add/modify 
groups, click the Slice Group 
Management button in the Page section 
of  the Control Panel. 

 
Add/Edit Group Name: Name of  the new 

group or the new name of  the selected 
group. 

 
Slice Type: Type of  slice for this group. 

 Arch Axial Slice: ArchSection Tab's 
axial slice mode 

 Arch Cross Slice: ArchSection Tab's 
cross-section slice mode 

 TMJ Left Cross Slice: TMJ Tab’s left 
cross slices 

 TMJ Right Cross Slice: TMJ Tab’s right 
cross slices 

 
Description: Optional description for group 
      
Add Group: Adds the new group to the 

template's groups. 
 
Edit Group: This will replace the selected 

group with the new group. If  the slice type 
changes, all of  the slices will be removed. If  
any slices in this group are not in other 
groups, they will also be removed from the 
case file. 

 
Remove Group: This will permanently delete 

the currently selected group from the 
current template. If  any slices in this group 
are not in other groups, they will also be 
removed from the case file. 

 
Selected Group: This holds all of  the existing 

groups on the template. Can be selected for 
Edit and Remove operations. 

The image on the left displays the corresponding slices for 
this particular Slice Group. 
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Adding Slices to a Group 
IMPORTANT: Only ArchSection and TMJ allow you to capture slices to a slice group. 
ArchSection and TMJ Tabs have a new toolbar button (shown below) that will enable the slice-capturing 
mode. While in this mode, you can see all the captured slices for a selected group. It also allows you to add or 
remove slices from the slice group. 
 
 

 

Slice Capture Mode – This will open up the dialog that will enable you to capture slices 
to a group. 

 
 
Capture Slices Dialog: 

 

 
 
 

 
 

 
Capture Target: Allows selection of  group to 
add/remove slices. All parameters are read-only 
here. The selection of  slices can be modified in 
the Slice Group Properties in the Report Tab. 
 Name: Name of  the current group 
 Type: This group's slice type 
 Description: Optional description for 

this group 
 
Action: Description of  the capture slice 
options (discussed in more detail in the next 
section). 

 
Select Range: Allows use of  the pano or 
frontal image to capture the slices. Press the 
Select Range button then pick two points on 
the pano to mark the start and end slices. All of  
the slices in between will be added to the group. 
The number of  slices depends on the slice 
interval and slice thickness set. 

 
Status: Allows viewing of  all slices in this group. 
 Number of  Captured Slices: List of  all 

slices in the current group with a count 
of  the total number 

 Remove Slice: Remove the selected 
slice(s) 

 Remove All: Removes all captured 
slices 

The image on the left displays the corresponding slice that 
would be captured with this Slice Group. 

Management 
 Manage Slice Groups: Opens the Slice Group Management dialog. 
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Capturing Slices 
 

There are three ways to capture a slice once you are in capturing mode in the ArchSection or TMJ Tabs. 
All captured slices for the current group will have their frames highlighted in green in the source tabs. 
Their locations will also be marked on the pano and frontal images. Arch axial slices will not be marked 
on the pano. Note: For the arch axial slice type, ArchSection layout must be in lightbox mode with axial 
sections chosen for capturing. Slices outside the selected group's slice type cannot be captured. 
 

Slice Capture 
 

o Single Slice Capture: Hold the “s” key on the keyboard and left-click any slice to capture it. 
The selected slice will be highlighted. Note: Repeating this will deselect the slice. 
 

o Group Slice Capture: Hold the “a” key on the keyboard and left-click any slice to capture it. 
Click on another slice, and all slices in between the two slices will be captured including the 
second slice. 
 

o Select Range: This will capture slices within a range designated in the pano or frontal images 
depending on the view. Note: This is not available for arch axial slices. 

 

 
 

The image above shows the configured slice range on 
the ArchSection pano 
Note: If  slices have already been captured to the 
Report Tab, white lines denoting these slices will be 
seen on the pano even before the Select Range function 
is used. Use the Toggle Visibility tool to hide these 
lines. 

Select two points on the pano in ArchSection or the 
frontal images in TMJ. 
 After clicking once on the image, a red line will 

appear. This is the starting slice of  what will be 
captured.  

 When clicked a second time, all slices between the 
red line and the second point will be captured. A 
second red line marks the end slice. White lines will 
denote every captured slice as defined by the cross-
section parameters. See image to the left. 

 A gallery image with the slice group name of  the 
pano or frontal will be added. If  it already exists, it 
will be replaced. Npte: This will replace any other 
image with the same name regardless of  how it was 
captured to Gallery. 
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Report: Adding Slice Group Controls 

Slice Group Controls can hold a series of slices. (See Report: Slice Group Management, pg. 144).  

Note: If no slice groups exist, you will be prompted to create one. 

 

Adding a Slice Group: 

 Click the Add Slice Group button.  
 Properties can be changed by clicking Properties in the Current Control section of  the Control Panel. 

 

 

Warning: When resizing a Slice Group control, note that the slice numbers will disappear if  the control 
is downsized past a limit (approximately the size that the numbers can no longer fit within each respective 
slice). 

 
 
Slice Group Box Properties: 
 

 

Source 
 Sync to Source: Select to update the image 

automatically if  it is changed. If  disabled, images can 
be refreshed with the Image Refresh button. 

 Slice Groups or Selections: Determines if  slices are 
added by group or individually by slice. See the next 
page for more information on Slice Image Source. 

Layout 
 Columns/Rows: Determines the arrangement of  

slices within the control.  
 Note: If  there are not enough rows and columns for 

the amount of  chosen slices, some slices will not be 
displayed. 

Display Mode 
 “Fit” will stretch the image to fit the control while 

maintaining aspect ratio. “Clip” will use clipping to fill 
the control space. 

 Image Alignment: Determines how the image will be 
oriented within the control. 

 See Image Alignment on pg. 151 for more details. 

Box 
 Size and color: Determines the size of  the text control. Unchecking “Transparent” will show the chosen 

color instead of  the report’s background color. 
 Border: Set the border style, color, and thickness. Style can be dashed, solid, or none (not displayed). 
 Ruler: Set on which borders rulers will be displayed and the color. 
Save As 
 Choose the name of  the control. 
Show on Every Page 
 Check this option to show the content on every page of  the template. 
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Slice Image Source Details: 
Images can be added to Slice Group Controls by group or by manual selection: 

 

 Slice Groups: Displays slices from a 
single group. Refer to Report: 
Capturing Slices (pg. 147) for more 
information on the restrictions and 
functionality of  slice range. 
 Selected Group: The slice group 

to use as the source. 
 Start Slice: First slice to be 

displayed from the group.  
 End Slice: Last slice to be 

displayed. 
 If  “All” is checked, all of  the slices 

from the selected group will be 
displayed. 

   

 

 Selections: Manually add captured 
slices one by one to be displayed.  
 Available Slices: All slices captured 

in the current case file. 
 Selected Slices: All slices chosen to 

be displayed in this control. 
 > Button: Moves selected 

Available Slice(s) to Current Slices 
for display. 

 < Button: Moves selected Current 
Slice(s) to Available Slices to no 
longer display. 

 If  “All” is checked, all of  the 
captured slices will be displayed.  
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Slice Control Selection Details 
Start and end slice are determined by their slice numbers. This number can be seen on each slice in the upper right. 
This is only enabled for single groups. When selecting the range of  slices to be displaced, the number indicates 
which slice in the series is shown and does not correspond to the slice number itself. 

 Start Slice: What slice in group to start displaying. 0 defaults to the first slice. 
 End Slice: What slice in group to stop displaying. 0 defaults to last slice. 

Slice Range Examples 
 You can show the first two slices by setting Start Slice to 1 and End Slice to 2. You could also show 

the next two by setting the start to 3 and the end to 4.  
 All slices can be shown by setting Start and End Slice to 0.  
 If  Start Slice > End Slice, only the End Slice will be shown. 
 If  Start Slice > Number of  slices and End Slice = 0 or End Slice ≥ Number of  slices, then only the 

last slice will be shown. 
 If  either is set to blank, they will default to 0. 
 If  End Slice > Number of  slices, the last slice will be the End Slice. 
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Report: Adding Single Image Controls 
Control that holds a single image from a selected source view. 

Adding a Single Image Control: 

 Click the Add Single Image button.  
 Properties can be changed by clicking Properties in the Current Control section of  the Control Panel. 

 
Single Image Box Properties: 

 

Source 
 Determines the exact image to be displayed from 

the source view (Note: Images will not be 
available until the specified source view has been 
“visited” to provide an image to load. See 
Report: Image Type Definitions, pg. 152, for 
details on dynamic images.) 

 Sync with Source, Display Mode, Image Alignment, 
Box dimensions and properties, Save As, and “Show 
on Every Page” control the same properties as for 
Slice Groups (see Report: Adding Slice Group 
Controls, pg. 147). 

 

Warning: Bitmaps under 24 bit 
may not display correctly. 
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Report:  Image Alignment 
For Slice Group Controls and Image Controls, images may be aligned to the control boundaries by two methods.  

 Fit: Resizes the image to fit within the borders of  the control as determined by the Image Alignment 
settings.  

 
This example is done with a bottom left fit alignment position with a white background.  

 

The image will originate from the bottom left and will show the background above it or to the right when it does 
not fill the control. 

 

 

 Clip: The original image size is maintained. The control may need to be resized in order to display the full 
image. 
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Report: Image Type Definitions 
Dynamic Images: 

These images will always be up-to-date with the latest changes performed on them if desired. When adding 
an image to a control, the user can choose to not auto-update the image, keeping the current image until the 
auto-update setting is changed or the image is manually refreshed. There are two types of dynamic images. 

Note: Capturing images from specific layouts requires that the layout is currently selected when leaving the aforementioned tab 
and reloading the Report Tab. Ex. The pano screen in the Implant Tab will not be captured unless the Pano layout is being 
viewed when leaving the view. 

 Single image view sources except Gallery and external images are dynamic. 
o To populate the image source with images, go to a view tab. As you leave the view, images for 

that view are captured. 
o After an image has been added to a control, it will update when changes are made in that view. 

For example, if  a measurement is added to Section Tab's axial view, the image in the Report 
Tab will now display that measurement. 

o These images are saved with the case file. 
 Slice images 

o These are captured manually. 
o These are the input for the Add Slice Control. 
o They have the same dynamic update behavior as above. 
o These images are saved with the case file. 

Static Images: 

These images will never change unless you manually change the source image. There are two sources of  static 
images. 

 Gallery 
o All images in the Gallery are either captured from other tabs or imported using the Import 

Images function. They will not always be life size. 
o These images are saved with the case file. 

 From a File 
o These images come from the local computer or another source. They will never be life size. 
o These images are saved with the template. 

o If  an image that already exists in the template is added, the software will prompt whether to 
replace the image or keep using the older one. 
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Report: Managing Templates 
Once a report layout is created, it can be saved and reloaded in other cases as a template. Templates are saved locally 
in the file path designated under “Template Path” in the Preferences dialog. These saved templates will automatically 
appear in the drop-down menu. To display a preview of  all the available templates or to edit them, click on 
Manage… on the Control Panel. 

 

Manage Preset Templates 
 All of  the saved templates will be shown here. 
 Each color represents a different type of  control: 
 Blue: Text control 
 Red: Image control 
 Yellow: Slice group control 

 Templates may also be loaded from this window by 
left-clicking on them. 

 Previous/Next: Goes to the previous or next page 
of  templates, respectively. 

 Edit List: Opens a dialog for editing template 
properties. 

 Close: Closes the dialog. 

 

Edit Template Presets 
 Add…: Load an existing template that was saved 

elsewhere. 
 Rename…: Rename the selected template. 
 Remove: Remove the selected template. 
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Report: Preferences 

 

 Default Control Colors: Colors for border, 
background, font, and rulers. 

 Default Image Type: Choose between “Fit” 
or “Clip” display modes. 

 Default Page Setup: 
o Printer: Printer in current use. This 

changes the available paper sizes. This list 
includes all of  the printers available to the 
computer. 

o Paper Size: Uses the printer drivers to set 
the height and width of  the page. 

o Orientation: Portrait or landscape setup. 
o Margins: Margins (in inches) for the 

template. Used for where controls can be 
placed. 

o Background: Color and transparent 
options. 

o Border: Color, thickness, and style 
options for the border. Styles are solid 
line, dotted line, or no line at all. 

o Margins: Margins for the border. This can 
differ from the page margins. 

 Behavior: Specifies behavior of  the template 
during design. 
o Enable Alignment Grid: If  checked, all 

controls will attach to their top left 
corner to the nearest grid point. If  
unchecked, they will be placed wherever 
the user drags them. 

o Display Numbers on Print: If  checked, 
the report page number will be displayed 
in the printout. 

Alignment Grid: 
 Grid dot spacing: Defines the distance between grid dots. 
 Grid dot color: Set the color of  the grid dots. 
 Hide Grid: Toggles the visibility of  the grid. 
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Report: Page Setup 
This displays and lets you configure all page settings. These are the settings the template uses. When printing, the 
correct printer and paper size must be chosen from the print setup. Note: The first time the software loads, your 
default printer configuration is used to set the printer and paper size for the report. Report defaults can be changed 
from the Preferences menu. 

 

 
 

Page Setup: 
To modify page settings, click the Page 
Setup Button in the Control Panel. 

 

 

Page Configuration: 
 Printer: Printer to use for this template. 
 Paper Size: Current Paper Size. Only 

displays paper sizes for the currently 
selected printer. 

 Paper Orientation: Portrait or landscape 
orientation. (Note: Margins will not 
change, so paper may appear to have 
different proportions when switching 
between portrait and landscape.) 

 Margins: Margins (in inches) for the page.  
 
Background: 

Checking transparent will show the chosen 
color instead of  the background. 
 

Border: 
 Set the border color, thickness, and style. 
 Style can be dashed, solid, or none (not 

displayed). 
 Margins: Location of  the borders. 

 
Page information of  your chosen configuration will always 
display in the Page section of  the Control Panel. 
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TxSTUDIO Software Troubleshooting 

Category Error Solution 

General Error Message: 

TxSTUDIO Application has encountered a problem and needs to close. We are sorry 
for the inconvenience. 

 

Click the “Don't Send” button. 
Check if  there are old versions of  optional plug-ins: remove them 
or upgrade them to be compatible with TxSTUDIO. 
Launch the TxSTUDIO application again. 

Warning: Treatment information can only be manually saved. All 
information added after last saving will be lost. 

Cannot launch TxSTUDIO Open Task Manager and check if  multiple instances of  
TxSTUDIO are already running. 
Close other TxSTUDIO processes. 
Launch the TxSTUDIO application again. 

Computer failure Launch the TxSTUDIO application again. 

Warning: Treatment information can only be manually saved. All 
information added after last saving will be lost. 

Error Message: There is no email program associated to perform the 
requested action. Please install an email program or, if  one is already 
installed, create an association in the Default Programs control panel. 

Install an email program. 

If  one is already installed, create and association in the Default 
Programs option in the Control Panel of  the computer. 

Installation Error Message: 

Server is not Responding 

Check Internet connection. 
If  Internet is connected, try again later. 

Error Message: 

Please run as administrator to activate software 

Run the installer/application as administrator. 

Error Message: 

Failed to verify the license code! 

Check the license code and try again. 

Check Internet connection and try again. 

Error Message: 

Wrong License Code! 

Check the license code and try again. 

Error Message: 

Invalid Authorization code 

Check the license code and try again. 

Error Message: 

Actual size of  the image can't fit to the paper size! 

Change printer setting or create an image with smaller size. 

 

File Operations Error Message: 

Failed to create process. Please close other applications and try again. 

Close all the other applications. 

Launch the TxSTUDIO application again. 

Error Message: 

Error: Cannot read this file 

Check if  this file is supported by TxSTUDIO. 

Message: 

Not enough memory 

Close all the other applications. 

Launch the TxSTUDIO application again. 

Error Message: 

Can't create temporary save file! 

Check if  the remaining disk capacity for the temporary folder is  
big enough. 

Error Message: 

Failed to read DICOM file! 

Check if  this file is supported by TxSTUDIO. 

Error Message: 

Can't read Dicot’s Image Data! 

Check if  this file is supported by TxSTUDIO. 

Try to open a file but nothing showing up Check if  this file is supported by TxSTUDIO. 

Error Message: 

Cannot save file! 

Check if  the file is the correct type. 

Check if  the file path is correct and folder is writable. 
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Image Rendering Error Message: 

Can't detect hardware acceleration for OpenGL support! 

Check if  the graphics card meets system requirements. 

Check if  the latest driver is installed for the graphics card. 

Image is distorted Switch to another view and switch back. 

Grayscale image shows up for all rendering presets Check if  the graphics card meets system requirements. 

Check if  the latest driver is installed for the graphics card. 

Warning Message: 

3D reconstruction may not work! 

Check if  the DICOM files are exported correctly. 

 
All other issues, please contact Osteoid Inc. Customer Support at (408) 333-3484. 
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This comprehensive list below provides a quick and easy way to find the relevant information that you would like to examine. 
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Photowrapping .............................................................................................................................................................................................. 128 
Pixel Values .................................................................................................................................................................................................... 47 
Pontics ............................................................................................................................................................................................................ 88 
Registration..................................................................................................................................................................................... 82, 108, 112 
Rendering Methods ......................................................................................................................................................................................... 54 
Rendering Window ......................................................................................................................................................................................... 17 
Report PDF ................................................................................................................................................................................................... 138 
Report View Tab ........................................................................................................................................................................................... 137 
Reset Zoom .......................................................................................................................................... 37, 44, 52, 61, 79, 93, 99, 103, 108, 125 
Restoration ...................................................................................................................................................................................................... 71 
Restoration View Tab ...................................................................................................................................................................................... 78 
Sculpt (Free Form) .......................................................................................................................................................................................... 52 
Sculpt (Point-to-Point) .................................................................................................................................................................................... 52 
Section View Tab ............................................................................................................................................................................................ 43 
Simulation............................................................................................................................................................................................. 127, 135 
Software Layout ............................................................................................................................................................................................. 17 
Stone Model ........................................................................................................................................................................................ 67, 81, 82 
Super Ceph ............................................................................................................................................................................................. 79, 103 
Super Ceph View Tab ................................................................................................................................................................................... 102 
Super Pano ...................................................................................................................................................................................................... 99 
Super Pano View Tab ...................................................................................................................................................................................... 98 
Superimposition Adjustment..................................................................................................................................................................114, 115 
Superimposition View Tab ............................................................................................................................................................................ 107 
Template ....................................................................................................................................................................................... 138, 139, 153 
TMJ View Tab ................................................................................................................................................................................................ 92 
Toolbar ........................................................................................................................... 17, 37, 44, 52, 61, 79, 93, 99, 103, 108, 119, 125, 138 
Tru-Pan ..................................................................................................................................................................................................... 39, 63 
vdata ......................................................................................................................................................................................................110, 117 
View Sequence ............................................................................................................................................ 37, 44, 53, 59, 62, 73, 93, 125, 136 
View Settings .................................................................................................................................................................................................. 18 
View Setup...................................................................................................................................................................................................... 53 
View Tabs ....................................................................................................................................................................................................... 17 
Volume Measurement ..................................................................................................................................................................................... 57 
Volume Registration ............................................................................................................................................................................. 108, 115 
Volume Render View Tab ............................................................................................................................................................................... 51 
Volumetric Measurement ................................................................................................................................................................................ 53 
Waxups ..................................................................................................................................................................................................... 66, 67 

 
 
 
 
 
 
 



 

ANA003 Rev G.  17 June 2022                                         Page 160 of 160                                                                       UM-TXS-ENG-54G 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

 

Manufactured by: 

 

Authorized Representative: 

Anatomage PaloDEx Group Oy 

3350 Scott Blvd Nahkelantie 160, P.O. Box 64 

BLDG 29 FI - 04301 

Santa Clara, CA 95054, U.S.A. Tuusula, Finland 

Tel: 1-408-333-3484 Tel: 358-10-270-2000 

Fax 1-408-295-9786 Fax: 358-9-851-4048 

www.osteoidinc.com www.palodexgroup.com 

 

 

 

0086 


